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IIIInnnnttttrrrroooodddduuuuccccttttiiiioooonnnn    ttttoooo    LLLLiiiiSSSSaaaa

What is LiSa?
LiSa (Live Sampling) is a real-time audio manipulation
environment that runs on any Macintosh or Mac OS-
Compatible computer with a Power PC Processor.  The
program uses the 16-bit AD/DA converters of these platforms
and the computing power of the PPC RISC Processor.  This
combination turns the Mac into a versatile audio sampling
machine.  Complete program control is possible via MIDI,
allowing the user to work with this system in performance.

LiSa was designed to fulfill the needs of musicians who work
with sampled and manipulated sounds and need more
flexibility than is generally available in a traditional sampler.
Not only can sounds be recorded and played back quickly
and easily in a performance situation, LiSa’s architecture
gives you direct access to the samples in memory, allowing
much more sophisticated manipulation of samples than is
possible in traditional samplers, both hardware- and software-
based.  In addition, LiSa offers a variety of algorithms for
processing sampled sounds, and is very well suited for a
broad variety of delay applications.

Version 2.0
The 2.0 release of LiSa contains many improvements and
changes over the 1.x releases, some visible, and some not.
They include:

•  Improved Sound Quality.  The internal sound playback
algorithms have been improved, giving better sound
quality overall, especially at lower transpositions.

•  Sample Editor.  The Sample Editor window allows for
better and more accurate placement of sounds in the
Sample Buffer.

•  Filters.  Playback Zones now all have an optional MIDI-
controllable bandpass filter.

•  Internal Modulators.  In addition to external MIDI control,
LiSa now has built-in modulators for parameter control.

•  Improved GUI.  The user interface has had many
improvements, including improved drag-and-drop, more
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consistent window management, and better access to
parameters via popup menus.

•  Balloon help.  Most of LiSa’s interface is now provided with
Balloon help, accessible from the Help menu.

New features of particular interest to version 1.x users are
flagged with the notification to the left.

Manual Conventions
In this manual, certain conventions will be followed for clarity:

•  All menu items, from either the main menu bar or popup
menus, will be printed in 9-point Charcoal.

•  All names of numericals or other words appearing in LiSa’s
windows will be in Helvetica Bold .

•  All illustrations will show time values in seconds and
milliseconds.

The LiSa Interface
Windows

The windows in LiSa look different from but are almost
exactly the same as traditional Macintosh windows.  The
main difference is that all windows are active at all times –
you can use any window without having to bring it to the front,
even if it is partially covered by another window.  A small
green diamond in the upper left-hand corner and the green
title color indicates the ‘top’ window (i.e., the one to which all
cut, copy, and paste operations are directed).

To bring a window to the top:

•  Select it’s name from the Windows menu

Don’t Forget:  the window
you’re staring at is not

necessarily the top window!
If you’re having trouble

cutting, copying, or pasting,
you probably don’t have the

right window on top

New in Version 2.0:
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•  Use the corresponding Cmd-key equivalent (visible in the
Windows menu)

•  Click anywhere in the window drag area, around the border
of the window

•  Click anywhere in the window while depressing the Control
key.

•  To move a window:
•  Click and drag anywhere in the window drag area, around

the border of the window

•  Click and drag anywhere in the window while depressing
the Control key.

Subdivisions of windows usually have a set of related data
input controls in them, or some set of related information.
They are called panes.  With the exception of the Sample
Editor, windows cannot be resized.

Popup Menus and

Numericals

Most of the data that you enter into LiSa’s windows will be
via either popup menus or numericals.  In general,
numericals appear as simple rectangular boxes, and
popup menus appear either as icons or as boxes with a
triangle on their bottom edge.

Using Numericals

A numerical is a box containing a number or text that can
be changed from either the mouse or the keyboard.
Values in a numerical can be changed three different
ways:

•  Scrolling:  Position the cursor in the box and hold down the
mouse button.  If the cursor is in the top half of the box,
the displayed values will increase; if in the bottom half,
they will decrease.  The cursor will change to an arrow to
indicate the direction of movement, and the numerical will
continue to change as long as the mouse button is held
down.

•  Dragging: Click anywhere in the box, hold the mouse button
down, and move the mouse forward or backward to
increase or decrease the value.  This is somewhat faster
than scrolling.

•  Typing:  Click once in the box, which will select it, type, and
hit Return or Enter.
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Numericals and Time descriptions

Time can be displayed in two ways in LiSa: either by seconds
and milliseconds, or by number of samples.  You can toggle
between these two options by using the Show Length in
Seconds/Samples option in the Options menu.  When viewing in
seconds, you can set time values with a precision of one
millisecond.  If you need to be 100% accurate, you can set
time in samples, down to the individual sample.  A numerical
can’t hold the often gigantic numbers required for counting
through a large buffer in samples, so when displaying time in
samples, they have two modes:

Counting by kilobytes (kB) of samples (that’s 1024 samples,
or about .02 of a second), or by individual samples (a very
tiny bit of a second).  When you have Show Size in Samples
selected, you will normally see time displayed in kB of
samples.

If the number is in normal type, that means the time selected
is an even number of kB of samples; that is to say that the
total number of samples in the numerical is evenly divisible by
1024.

If it is in bold, that means that there are samples left over –
the total number of samples in the numerical is not divisible
by 1024.

To fine-tune this number, press the shift key, and the number
of samples left over in the numerical will appear.  This is the
fine-tune aspect of the numerical.  To change this number
select the numerical while the Shift key is depressed.  You
can release the Shift key at this point, and the numerical will
remain selected.  Scroll or type as usual.

Dual Numericals

In some cases, a numerical may be used to set more than
one parameter.  In these cases, mentioned in the manual as
they appear, holding down the Shift key will reveal the second
parameter.  These dual numericals are never related to
precise time values, and do not relate to the situation
described above.

Editing Functions

The standard Macintosh editing functions (Cut, Copy, Paste,
and Undo) are implemented in different ways in different
windows.  All numericals and text boxes in Editor windows, if
selected, can be copied and pasted into any other numerical
for any other Editor.  Undo will also work normally in a
selected text box.

If no numericals in an editor window are selected, selecting
Copy will copy the entire data structure (Envelope, Zone,
whatever) to the clipboard.  This can then be pasted into a

Note that once a numerical is
selected, you have to deselect
it in order to change it’s aspect

with the shift key.

New in Version 2.0: All
numericals which formerly

contained controller names or
any other non-numerical data

are now popup menus.

New in Version 2.0:
Extended editing functions
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new structure of the same type.  All parameters, including the
name, will be copied over.

All editing commands are always directed to the topmost
window eee

Fundamentals of LiSa
Overall Structure

LiSa’s overall architecture is divided into Setups, Presets, and
Zones.  Data that LiSa uses is stored in Libraries.  The file
you load when you start up a program is a Setup.  Each
Setup is comprised of up to 128 Presets, which are the
immediate sound and control environments you are working
in when editing or performing with LiSa.  A Preset is
comprised of up to 2048 Zones, which contain all the actual
information regarding sample performance and manipulation,
plus a set of MIDI controller and keyboard connections to
direct how MIDI will effect your sounds.

Sound in the Computer

LiSa, like all samplers, works by loading sounds into a
contiguous chunk of RAM, known as a buffer.  The key
difference between LiSa and traditional samplers is that you
have direct access to all parts of the Sample Buffer via MIDI.
All sounds loaded into LiSa are stored in one large buffer;
one sound lined up after the other.

You access this buffer by creating Zones.  A Zone is
comprised of three aspects: A keyrange (or range), a
function, and a sample region, or region.  Zones are activated
(played) by MIDI ‘note on’ messages.

•  The range is the key or keys (MIDI notes) that activate the
Zone.  These are specified in the Assignment Window.
The same Zone can be assigned to different keyranges in
different MIDI channels.

•  The sample region is the physical area of the Sample Buffer
on which the Zone operates.  It can be all or part of the
buffer, and its exact size and location can be either set
permanently or controlled via MIDI.  These initial
parameters are set in the Zone Editor window.
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•  A function is what the Zone does to the Zone’s region.
Playing back, recording, and loading sounds from disk are
all examples of functions.

When a Zone receives a note on message in its keyrange, it
does its thing, whatever that may be.  A typical Preset would
be comprised of some number of Zones for playback,
recording sounds live, and loading samples from disk.

Libraries

All of the data LiSa uses in a Setup – Zones, samples, tables,
and so on, are stored in a set of Libraries.  They are
independent data banks, and can be shared between Setups.
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A Quick Tour
These are the main windows used when programming and
performing with LiSa, with brief descriptions of their general
functions.

The Assignment Window

The Assignment window provides you with the basic
information about your Preset, the actual ‘instrument’ you are
working with at any given moment.

In the upper left-hand corner, you can see the name of the
currently loaded Setup – this is your open file.  To the right is
the name and number of your currently loaded Preset.  Every
Preset has both a name and a number, which is the number
of the Program Change Message that loads it.
A Setup can contain up to 128 Presets.

Below, with the keyboard inside, is the Zone Assignment
pane.  Here is where you assign Zones to a keyrange for
activation, and assign MIDI channels.

At the bottom of the window is the Parameter Control pane.
This is your ‘patchbay’ for MIDI and internal modulation
control.

Each Preset is comprised of up to 16 Voice Layers (see
p.88), indicated by the row of numbered buttons above the
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keyboard.  Each Voice Layer can respond to a different MIDI
channel, and have a different set of key assignments and
Parameter Control options.  When nothing is selected in the
Assignment Window, selecting Copy from the Edit menu will
copy the entire Voice Layer to the clipboard, from which it can
be pasted into a Voice Layer in the same, or another, Preset.

The Zone Editor

The Zone Editor is one of the most important parts of LiSa.  It
is the window in which you determine both the function and
the sample region of a Zone.  Its exact appearance will vary
depending on the kind of Zone that you are editing.

As in the assignment window, you can see the name and
number of the Zone on top.  Unlike Presets, these numbers
have no particular meaning – they are LiSa’s catalog
numbers.

To the right of the Zone name are a row of icons.  When
clicked, they reveal a series of popup menus, which
determine the function of the Zone (record, playback, etc.)
and the modes of that function.  A Zone that plays a sample
backwards has the same function (Playback) as one that
plays it forwards, but with a different mode.

The Region pane is where the sample region of the Zone is
set.  In some functions this pane will include other options
such as tuning.  These parameters are usually MIDI
controllable.

The Treatment pane contains parameters specific to the
Zone’s function, and the parameters available can change a
great deal depending on the function of the Zone.  It can
contain such things as input and output levels, processing
parameters such as distortion, or the name of a file to be
loaded.
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The Status Window

This is the main widow for performance and real-time
information.  It is dominated by the Sample Buffer pane,
which shows the sounds you are working with.  It also
contains information on current MIDI input, processor load,
and other miscellaneous information.

The Sample Editor

The Sample Editor window is an environment in which more
detailed manipulation of samples is possible than in the
Status window.  Samples can be dragged to the Editor from
the Sample Library, edited, and resaved to your hard drive as
new samples.

New in Version 2.0



10

Libraries and Editors

All of the data used in LiSa is stored in Libraries: Zones,
Envelopes, Tables, Controllers, Patterns, and Samples.  We
have already encountered the Zone and Sample editors, and
the others will be explained in future chapters.  Double-
clicking on an item in a Library will open up the associated
editor, or you can open the editors from the Windows menu.
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SSSSeeeettttttttiiiinnnngggg    uuuupppp    LLLLiiiiSSSSaaaa

Hardware
LiSa will run on all desktop and laptop Macintosh and MacOS
compatible PowerPC computers.  Although you can use any
monitor it is strongly advised to use a color monitor,
preferably a multi-scan so that you can use the highest
resolution possible.  An external MIDI interface is also
required for connection to your keyboard or other MIDI
controller.  This can be connected to either the modem or the
printer port of your computer.

To take full advantage of LiSa, it is also necessary to have
some kind of MIDI instrument.  In this manual we will assume
you have a velocity-sensitive keyboard with pitchbend, a
modulation wheel, and aftertouch.

Memory
LiSa requires at least 10 MB of RAM to operate, so a total of
at least 32 MB of RAM is recommended for your computer.
The sounds used by LiSa are stored in RAM, so the more
RAM you have available above and beyond that, the longer
your Sample Buffer can be.

Recommended memory assignment (in the Information panel
for LiSa) is 20638 kB.  Memory you assign to LiSa’s buffers
will also be included in this number, so it needs to be fairly
large.  For every additional MB of RAM you assign to LiSa,
you will increase your buffer space by approximately 12
seconds.  If you have assigned more memory to LiSa than
your machine has available, you will probably get a dialog at
startup indicating that OMS is not installed.  This is because
LiSa eats the memory that OMS would normally take, and
once LiSa has opened, OMS can’t find the memory it needs.
If you get this warning and know you’ve installed OMS, quit
LiSa.  Select it in the finder, and choose Get Info... from the
Special Menu in the Finder.  From there, you can resize the
memory to a lower value in the Information panel, and open it
up again.  If that does not help, open the Preferences folder
in your computer’s System folder and throw away the file
‘LiSa Prefs’.

Problems have been
discovered running LiSa
on the PPC 7500 with

system version 7.5.2.  If
you have such a Setup

and are having problems
running LiSa, upgrade
your system to 7.5.3 or

higher.



12

System settings and Sound
Manager
LiSa is compatible with all versions of the Mac OS for Power
PC; however, make sure that Sound Manager version 3.3 is
installed regardless of your hardware or system version.

Check your ‘Memory’ control panel.  LiSa will not run properly
unless memory settings are correct.

•  Virtual memory should be off.  LiSa will run with Virtual
Memory on, but it will slow down the program immensely.

•  Modern Memory Manager must be on.

Sound control Panel
Settings
Depending on what version of the Macintosh OS you are
running, you will have a slightly different version of the
‘Sound’ or ‘Monitors and Sound’ control panel, so all the
options described below may not be available here.
Whatever the layout is, you should set it to the following:

Sound in

•  If you have a Macintosh with RCA (Cinch) audio inputs,
(which operate at standard -10 dB line level) you should
select External Audio.

•  If you have only a mini-jack microphone in, select
Microphone.  (On some more recent versions of the Mac
OS, this is called Sound Input)

•  If you wish to record samples from your computer’s internal
CD-ROM, select Internal CD.

Sound out

•  Sample Rate can be set to anything.  LiSa uses 44.1 kHz
internally, and it is not connected to this control panel.

•  Size set to 16 bit.
•  Use set to stereo.

A note on audio cards:
As of this writing, LiSa is
only compatible with the
Korg 1012 Audio Card.
Only the first two inputs

and outputs will be
available
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Audio Setup
Input

LiSa accepts signals directly from the audio inputs in the back
of your Macintosh.  The Sample Buffer itself is mono, but it is
possible to record stereo samples.  (See Appendix 3:  Stereo
Recording, p. 109.)  Whatever your sound source is, it is
important to run your input through some kind of a preamp or
mixer in order to be able to set your levels properly.  You can
set an overall level for recording input in the System Settings
dialog, see (System Settings, p. 17).

When you have audio input, you should see some activity
in the input level meter at the bottom center of the Status
window.  The recording input bar is split for the left and
right channels.

If you are sure your lines into the computer are good, but still
aren’t seeing any input, quit LiSa, go to the ‘Monitors and
Sound’ (or ‘Sound’, depending on your OS version) control
panel in the Finder, and make sure the sound input is set
correctly.  If you use the Control Strip, make sure the Sound
Input module is in agreement with the Control Panel setting.
Set your mixer levels so that the input level meter is as high
as possible without going into the red.

Output

LiSa outputs in stereo, so you should take both of the outputs
from the back of your Mac and send them to a mixer.  This
signal will need some kind of amplification before you send it
to your speakers.

MIDI Setup
Connecting MIDI

LiSa needs some kind of MIDI input to take full advantage of
its capabilities.  (Some MIDI may also be generated from the
computer keyboard and the mouse – see Controlling LiSa
from the Computer, p. 102.)  You will need a MIDI interface,
and OMS, preferably at least version 2.2.  Plug your interface
into either the modem or the printer port of your computer,

A current version of the
Apple Sound Manager is

available at
http://www.apple.com.  The
latest version of OMS can

be downloaded at
http://www.opcode.com
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and the MIDI out from your controller into the MIDI in plug of
the interface.
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Configuring MIDI

In order for your MIDI instrument to properly communicate
with LiSa, you need to specify which ports are in use for MIDI.
This is done in the MIDI Setup... dialog in the Global menu.

Preferences
Preference settings for LiSa (found in the Global menu) are
stored in its Setup files.  This means that for each LiSa Setup
you have, you can have completely different set of
preferences.  A new Setup will start with the preferences from
the last Setup opened.  Aside from the Midi Setup… menu
item, there are three others:

Size of Buffers

The Sample Buffer is the part of your computer’s
RAM that is assigned to storing the samples you
play in LiSa.  It can be as large as your
computer’s memory allows, but you must assign
the memory space in the Get Info... dialog in the
Finder.  (see Memory on p. 11) There are
actually 3 buffers in LiSa, and each of them can
be set individually through the Size of Buffers…
dialog in the Global menu.  The size of these
buffers can be set either in seconds or kilobytes
of memory, depending on whether the View Size
in Samples option is selected in the Options menu.

New in Version 2.0:
MIDI Received by LiSa
can be passed through
to other applications or

instruments.
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Sample.  This is the buffer that actually holds the
samples you work with, and is represented in
the Status window.  This is LiSa’s main
workspace, and the most important of the three
buffers.

Output.  The Output Buffer records whatever you
have played most recently, including your
silences.  You can save this buffer to a
soundfile in order to listen back to what you
have just played, or for further processing later.
It does not automatically record; it has to be
activated via MIDI.

Process.  The Process Buffer holds the last piece of
sound you produced.  If you play for a minute,
and then don’t play for ten, that minute (or
however long, depending on your buffer size)
will still be in the buffer.  This buffer is
specifically designed for resampling something
you have already played in a live situation (for
more on these two buffers and their functions,
see Copying Buffers on p. 84).  It’s best to
think of the Output Buffer for saving or editing
sounds at a later time, and the Process Buffer
as a tool for live performance.

Global Settings

Global settings may be found in the System Settings… item in
the Global menu.  It is divided into three sections:

MIDI Settings

In this section, you can set MIDI for
commands to LiSa’s system.

System Channel.  This is the channel on which you
make commands to LiSa’s system,
independent of Zone activation and other
performance-related commands.

Output Buffer Rec. Start.  Any value sent on the
selected controller number on the System
Channel will initiate Output Buffer recording.

You will also notice (if you
are using the View Length in

Samples option) that the
Process Buffer is measured

in kilowords, rather than
kilobytes.  (A kiloword is

twice the size of a kilobyte).
That is because it saves

stereo samples, which will
take up twice as much

space per second in your
RAM.  If you resample from
this buffer, however, it will

be automatically mixed and
converted to a mono

sample.  This also means
that if you are viewing the
buffer size in seconds, the
Process Buffer will take up
twice as much memory per
second of length than the

other buffers.
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To find out what this means, see Copying
Buffers, p. 84.

Amplify Current Zone.  Any value sent on the
selected controller number on the System
Channel will amplify the Region of the currently
active Zone by the value specified in the
%Gain numerical.  This is described further
under the heading Amplify Current Zone, page
100.

System Settings

Max Voices CPU Load.  LiSa will tend to demand as
much of your computer’s processor time as it
needs to do whatever it has to do.  This can be
a problem if you are attempting to run LiSa in
tandem with other applications on your
computer, as LiSa can easily freeze them out.
(The Status Window provides you with a
running display of how much of your
computer’s CPU time is being used by LiSa.)
It is best to keep this as high as possible while
remaining compatible with other applications,
because the lower the CPU load maximum, the
fewer voices you will have available in
performance.  It is also possible that when
running with too many voices that some of
them are ‘hiccuping.’  This is a sign that your
CPU is overextended.  Reducing this value will
decrease your absolute number of voices, but
they will play smoothly.

 Input Gain.  Overall attenuation of your input signal
to the Macintosh’s analog/digital converters
can also be set here.  This numerical has a
range of 50% - 150% of the original input level.
If your computer is an AV model with RCA
(Cinch) type audio inputs, setting this
numerical to 50% guarantees that virtually
nothing you put into the computer will be
clipped.  If your input source is weak, however,
you can raise it as needed.  For models with a
miniplug audio input, it is less sure that you will
be distortion-free, but it’s not easy to overdrive
it.  We recommend that you keep this at about
60%, and only increase if needed.

Sound Thru.  This sets whether input sound will go
directly through to LiSa’s outputs.  If 0 is
selected, no external sound will pass.  Any

When using any of the new
blue and white Macs (iMac,

B&W G3/4, etc.) if your Input
Gain  is set to 50%, the

computer will interpret this as
an input mute, and no sound
will come into your machine.
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other number enables input sounds to pass
directly out.  The number chosen has no effect
on volume.

Envelope Followers

One of LiSa’s new features is the ability
to translate its audio input into MIDI,
which can be used as controls for Zone
parameters.  (See Envelope Followers on
p. 101 for more on this topic).

EF Channel.  The MIDI channel on which the
Envelope Followers will send data.

EF Note Number.  The MIDI note number that will be
activated when the Threshold is exceeded.

EF Threshold.  The relative amplitude value at which
a MIDI note on will be triggered.

EF Contr. Nr.  The Controller number that will follow
the amplitude envelope of the incoming signal.

New in Version 2.0:
Envelope Followers

convert audio input to
MIDI



19

ZZZZoooonnnneeeessss
Zones are the primary link between the performer and the
sound material.  All actions in LiSa are initiated through
Zones.  It is important to familiarize yourself with some basic
ideas about Zones and procedures for editing them, or you
will quickly get lost further on.

Structure of a Zone
A Zone can be thought of as the link between the keyboard
(or other MIDI input) and the Sample Buffer.  Playing notes
on the keyboard can initiate all the basic activities of
recording and playback, loading and saving soundfiles, and
most other real-time actions LiSa performs.  There are 3
basic elements to a Zone:

•  Keyrange, or range.  This is the key or keys that activate
the Zone, i.e., tell it when to start or stop.  Zones may
respond to any MIDI note in the range 0 - 120 (c-3 to c10),
on all 16 MIDI channels.  Any one Zone can be activated
by any number of keyranges on different MIDI channels.

•  Function.  A function is what the Zone actually does --
record a sample, play it back, or load or save from disk.
Each function has further sets of options called modes.

•  Sample Region, or region.  This is the segment of the
Sample Buffer on which the Zone operates.  It can be any
size within the limits of the buffer, and can be resized and
moved via MIDI.

Zone Libraries
Zones, like all other data in LiSa, exist independently of any
individual Setup, and are saved in Library files.  Different
Setups can use the same Zones by using the same Zone
Library.  When you save a new Setup, the Library will
automatically be named with the Setup, but it is now a
separate file, and can be loaded into any Setup you wish.
For more on loading and saving Libraries, see Libraries, page
31.

All the Zones for a Setup are stored in the same Library.
Each Library can hold a maximum of 2048 Zones.  Double-
clicking on a Zone in the Library makes it appear in the Zone
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Editor window.  Zones can be cut, copied, pasted or
duplicated in the Zone Library.  If you want to make a
duplicate of a Zone (for example to create a Zone that is a
slight variation of another Zone) you can select a Zone in the
Library, and select Duplicate from the Edit menu.  A new Zone
will appear with the old Zone’s name plus a star (*).  If a Zone
is assigned to a key somewhere in your Setup, a bullet will
appear in front of the Zone’s name in the Library window, so
you can immediately see which Zones in the Library are in
use.  The bullet marks will only be updated when you store
the current Preset.

Creating a Zone
All Zones are created in the same way, regardless of their
function.  In the upper-right-hand corner of the Zone Library
window is a button marked New.  Click on this button, and a
new Zone will appear listed in the Library.  It will also appear
in the Zone Editor with some sexy name like ‘Zone Nr 13.’  All
Zones begin life as Playback Zones, and it is in the Zone
Editor that you can change its function, set it’s parameters,
and rename it.

The Zone Editor

The illustration above shows the Zone Editor, as it appears
when a Fresh Zone is created.  This is the window for a
Playback Zone.  Both the function icon and the title below it
display the Zone’s function.  If you change the function of a
Zone, changes will appear in the window layout.  These will
be discussed in greater detail in their respective sections.

Each Zone listed in the Zone
Library has a one-letter prefix

indicating it’s type:
 p:Play

 r: Record
l: Static Load

d: Dynamic Load
c: Copy Buffer

∑: Load Session
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The Zone information Pane

The top pane of the window contains the most basic
information about the Zone:

Number.  This numerical shows the catalog number of
the Zone.  Zones are numbered sequentially in
the order of their creation.  This number is
LiSa’s internal reference to the Zone, and
cannot be changed.  In order to edit a Zone,
you may use the Zone Number numerical to
select the Zone of your choice, or double-click
on the Zone’s name in the Zone Library.  You
can cycle through available Zones in the Zone
editor by using the left and right arrow keys.

Name.  In this box (which is not a numerical) you can
rename the Zone.  Clicking in it once selects
the whole box, and you type the name in.
Zone names may be up to 15 characters long.
To move the cursor in the Name box hold the
mouse button down for a second when you
click in it, and the cursor will appear.  You can
then move it around with the arrow keys.
Hitting Enter will make the new name appear in
the Zone Library.

Function Button.  This button, just left of the name,
above the label Play in the picture above,
determines the function of the Zone.  Clicking
on this button brings up a popup menu, from
which you can select a function.  Once this is
selected, the name of the function will appear
below the icon, and the window will be
reconfigured for that particular type of Zone.

Mode Buttons.  The buttons to the right of the
Function button vary in number depending on
the Zone’s function, and control various
parameters relating to the Zone -- we’ll look at
these in more detail in the chapters on the
specific Zone functions.

The Region Pane

In this section, the bottom left part of the
editor, the sample region, movement range,
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and tuning for the Zone are set.  See Defining Sample
Regions, page 24 for more details.

The Function Pane

This pane contains information specific to the function of the
Zone being edited, and varies the most from one function and
mode to another.  As this image is taken from a Playback
Zone, it is in here called the Play Treatment pane.

Setting Keyranges
Basic Info

To assign Zones to MIDI note events, you need to open the
Assignment window from the Windows menu.  This window
has the current Setup’s name as the window title, so initially
its title will be ‘Untitled Setup’.

The Assignment window is divided into three parts.  Here we
will be primarily discussing its relationship to creating and
applying Zones.  For its other functions, see the chapters
Presets, Setups, and Libraries on p. 27, and Parameter
Control on p. 86.
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  The Zone Assignment pane of the Assignment window has
two parts to it, a row of buttons (actually popup menus)
labeled Voice Layers , and a representation of a keyboard.
The Voice Layer buttons indicate which Voice Layer is
currently being shown in the keyboard below.  Each Voice
Layer responds to a particular MIDI channel.  (For a full
explanation of Voice Layers and MIDI channels, see Voice
Layers and MIDI Channels, page 88.)  In a new Setup each
of the 16 Voice Layers is assigned to MIDI channels 1-16.

The keyboard itself represents MIDI note on events, from 0 to
120.  The numbers below the keyboard indicate the MIDI note
numbers of the keys.  As most keyboards cover the range of
MIDI notes from 36 to 96 (c1-c6), that is the default for the
visible range.  You can see lower or higher notes on the
keyboard by clicking on the arrow buttons above the
keyboard on the right- and left-hand sides, which will move
the visible section of the keyboard an octave at a time.  It is
on the keyboard that you assign Zones to virtual keys.  This
determines which MIDI note on events will activate which
Zones.  A Zone can occupy as much or as little of the
keyboard as you like, although it is usually unnecessary for
Record or Load Zones to occupy more than one key.  The
one exception to this is Load Session Zones, p. 82.

Creating a keyrange

Select the Voice Layer of the Setup you want the Zone to be
activated from, by clicking on the appropriate Voice Layer
button above the keyboard.

In the Zone Library, click on the Zone you want to assign to
the keyboard, and drag it over to the keyboard.  Hold it over
the key you want to assign the Zone to, and release.  The key
will now change color.  Each Zone is arbitrarily assigned its
own color, and the sample region it occupies in the buffer will
appear in the same color in the Status window.  One Zone
may have 2 or more non-contiguous ranges on the keyboard.
(You may also drag samples from the Sample Library directly
to the keyboard to create new Playback Zones, see Quick
Zone Creation, p. 52)

To extend the range of the Zone, click-drag from the starting
key over the keys you want to have the Zone play on.  You
can resize the Zone this way at any time.

Deleting a keyrange

To remove a keyrange entirely from the virtual keyboard,
click-drag an unassigned (uncolored) key over the keyrange.
Assigning a new Zone to the lowest key of a keyrange will
also delete that entire range from the keyboard.  If the
keyrange is trapped between two other ranges you don’t want
to change, you can clear an individual key by Cmd-clicking on

Keep in mind that the
keyrange of your Zone

indicates your  access to it
only, and is in no way

connected to how much of
the buffer it reads.  Keyrange
assignments & sample region

assignments are wholly
unrelated.

No two Zones can occupy
the same key on the same
Voice Layer at one time.

Whichever Zone is dragged
over a key last will be the
ONLY Zone that will be

activated by that key in that
Voice Layer.
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any key in the unwanted Zone.  From there you can drag the
unassigned keys over the rest of the unwanted Zone.

Finding Zones

Once you have created a large number of Zones in a Setup,
it’s not hard to lose track of them.  To find out if a Zone is
used in your Setup, check in the Zone Library window. If
there is a bullet in front of its name, it is in use in the Setup.
(These will only be updated when the Preset is stored).  To
find out where a Zone is in your Setup, select the Zone you
are looking for in the Zone Library, and choose Find Selected
Zone from the Edit menu, or press Cmd-F.  LiSa will then
locate the Zone, load the Preset that it is in, and flash the
lowest key of the Zone in the virtual keyboard.  If it is loaded
into more than one place, Find Zone Again (Cmd-G) will locate
its next appearance.

Defining Sample Regions
There are two ways to define a sample region: either using
the numericals in the Region pane of the Zone Editor, or by
directly applying values from the Sample Editor.  The sample
region you define will be visible in the Sample Buffer pane as
a segment the same color as the keyrange in the Assignment
window.

Sizing regions from the Zone

Editor

The Region pane of the Zone Editor,
regardless of the function of the region, will
always contain the two numericals below:

Stt.  Start of region.  This sets how far into the buffer
the Zone begins.

Len. Length.  This determines the length of the region,
how broad an area within the buffer the Zone
uses when activated.

To the right of each of these numericals is a box labeled
CTab.  These are part of the Parameter Control
implementation, and will be described in full in Mapping MIDI
Controllers – CTabs on p. 97.

Warning:  When Finding a
Zone, LiSa will load the

entire Preset, including a
new sample into the buffer

if there is one, so make
sure you’ve saved all
changes to the Preset

you’re working on before
you Find a Zone
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   Sizing Regions from the Sample

Editor

Instead of defining the start and length of your Zone’s view by
changing the Stt and Len numericals, you can also do it directly
in the buffer, by selecting parts of the buffer and then applying
them to the Zone currently being edited.  In version 2.0, these
operations are performed in the Sample Editor window.

To apply a selection in the Sample Editor to the current Zone:

Click-drag through the portion of the buffer you wish
to select.  The start and length values will
appear in the numericals labeled section at the
top of the window, and the selected region will
be highlighted.  Select Enter Selection in Zone
from the Edit menu, or press Cmd-E.  The
selected region will then become the Zone’s
sample region.

You can nudge the start point and length of the region by
holding down the Option key and pressing the arrow keys on
your computer keyboard.  It nudges in increments of 1 kB of
samples.

•  Option-Arrow left will move the start point earlier in the
Sample Buffer (i.e., to the left).

•  Option-Arrow right will move the start point later in the
buffer (to the right).

•  Option-Arrow up will increase the length of the region.
•  Option-Arrow down will decrease the length of the region.

Zone Functions
Each Zone has a function, which can be can be changed
using the Function button in the Zone Editor window, the first
of the row of icons in the top-right of the Zone Editor.  Here
the general function options of Zones are described.  Specific
modes for each of these functions are discussed in the
following chapters.

Playback.  Activating a Playback Zone will play back
all or some part of the Sample Buffer.  Each
Playback Zone can be individually tuned as far
as which area of the buffer it will play, and how
it will play it.

 Record.  Activating this Zone will cause some part of
the Sample Buffer to be overwritten with new

The key commands will only
change the region size if

there is no selected area in
the sample editor.  If part of

the sample editor is
highlighted, then they will

change the size of the
selected area, not the

region.

New in Version 2.0:
regions are now sized

from the Sample
editor, and no longer

from the Status
Window
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sounds from a live source, and optionally
saved to disk.

Load Sample. Static and Dynamic Load Sample
Zones load soundfiles from disk into the
Sample Buffer, which can then be used by
Playback Zones.

Copy Buffer.  This Zone resamples your own output
from LiSa after it has gone through some kind
of transformation, and puts it back into the
Sample Buffer to be played again.

 Load Session.  A Load Session Zone is a special
bank of Load Sample Zones, designed
especially for retrieving live recorded samples
created during a performance.

All Zones have certain parameters in common, and others
that are unique to their function.  These parameters are
initially defined when the Zone is created in the Zone Editor.
Most of them are also controllable in real time via MIDI or
internal modulators.  Connections between MIDI control and
Zone parameters are made in the Assignment window,
described in Parameter Control, p. 86.
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PPPPrrrreeeesssseeeettttssss,,,,    SSSSeeeettttuuuuppppssss,,,,    aaaannnndddd
LLLLiiiibbbbrrrraaaarrrriiiieeeessss
Above Zones in LiSa’s overall architecture are Presets and
Setups.  The file you load when you start up the program is
called a Setup.  Every Setup is comprised of up to 128
Presets, which you can switch between in performance using
MIDI Program Change messages.  A Preset is what you are
actually working with at any one time when programming or
performing with LiSa.

Presets
A Preset is the basic performance unit of LiSa.  When
performing or editing, you work with only one Preset at a
time.  A Preset is comprised of two parts: Up to 1920 Zones,
organized into a maximum of 16 Voice Layers (see p. 88),
and an optional sample to be loaded into the Sample Buffer
with the Preset.  You access Presets through the Preset
Window, where you can also set parameters for initial sample
loading and playback quality.

The Preset Window

The Preset window
is where you can
find basic
information about
the Presets in your
Setup.  It
resembles, but is
not identical to, the
Library windows we
have encountered
so far.  It is
available in the
Windows menu, or
by pressing Cmd-9.

Unlike Library windows, there are already 128 Presets in the
Preset window.  A new Setup will have one Preset already
made, called Init Preset .  The other Presets, although
visible, are empty, and have not yet been initialized.
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Creating and Coppying

Presets

To create a new Preset:

Double-click on an empty Preset in the Preset
window.  You will get a dialog asking you if you
want to create a new Preset.  Clicking ‘OK’ will
automatically create and load it.

Select an empty Preset and then select Load Preset in
the Presets menu.  The same dialog box will
appear.

To copy a Preset:

Select Store Current Preset As…. From the Preset menu.
You will then be given the option of which
position you want to store the copied Preset
into.

Once the new Preset is created, you can rename it in the
Assignment window.  This new name will not be reflected in
the Preset window until you store the Preset using either the
menu item Store Current Preset or Store Current Preset As…
Using the former will store it in its current position, and the
latter will allow you to set its number, and thus the number of
the Program Change message that will load it.

Deleting and Clearing

Presets

An ‘Empty Preset’ as seen in the Preset window takes up no
space on your hard disk.  If you decide you don’t need a
Preset or want to start from scratch, there are two menu
options available, both in the Preset menu:

Clear Current Preset.  Whatever Preset is currently
visible in the Assignment window will be
cleared.  All Zones will be removed, and all
MIDI connections broken.  Libraries will be left
untouched -- any Zones, Envelopes or
Patterns you have created, even if they’re not
used anywhere else, will not be deleted.
Memory allocation will not change, and the
34K of memory the Preset occupies will still be
occupied.

Delete Selected Preset.  Selecting this item will
completely delete the Preset selected in the
Preset window.  Libraries will still remain, but
the memory the selected Preset occupies will
be cleared.  It is not possible to delete the

Presets and Memory:
 It is important to note that

every time you create a new
Preset, your Setup file will

increase in size by 34 Kbytes,
even if there is nothing in it.  A
Setup containing the maximum
possible number of Presets will
thus be almost 4 MB.  Thus it is
advisable to use the minimum
possible number of Presets,
and to make sure that any

created Presets are actually
being used.

Note that unlike Libraries,
there is no particular need to
create Presets in numerical
order.  Since Presets are

accessed via MIDI program
change messages in

performance, you can ‘fill’
any empty Preset you wish

to match any program
change numbers you

choose.
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currently active Preset.  To delete a Preset,
you must open another one and then delete
the unwanted Preset.

Viewing and Editing Presets

To load a Preset into the Assignment window:

Click on the Preset Number numerical at the top of
the Assignment window.  This works identically
to the Zone Number numerical in the Zone
editor.  You can scroll to or type in the number
of the desired Preset.

Press the up or down arrow keys.  (This will scroll
between created Presets only.).  The up arrow
key will give you the next higher numbered
Preset, and the down arrow key the next lower
one.  The selected Preset will change only in
the Assignment window -- you will not see the
selected Preset change in the Preset Window.

Click on a Preset in the Preset window, and select
Load Selected Preset from the Preset menu.

Double-click on a Preset in the Preset window.

Preset Options

Loading samples with a Preset

When you load a new Preset, you have
the option to load a sample with it.  To
choose a sample from disk to load,
select the sample from the Sample
Library and drag it to the Sample
column of the desired Preset in the
Preset window.  It need not be the
currently active or selected Preset.  The
selected sample will always load from
the beginning of the Sample Buffer.

There are five loading options for Preset Images; each
represented by a different symbol in the Load column in the
Preset window.  Clicking on one of these will bring up a pop-
up menu with the options below.  In all of them except Clear
Buffer , the effected area is limited to the region of the buffer
into which the new sample is loaded

When the Preset number
appears in Bold in the

Assignment window, that
means it has unstored

changes.
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-- No Load.  No sample will be loaded.

• Replace.  In this mode, the new sample will
completely replace whatever was in the region.
Parts of the Sample Buffer beyond the original
sample will remain untouched.

Ø Insert.  Any silences currently in the effected
region will be filled with sound from the loaded
sample.  The new sample is layered directly on
top of the old buffer.  For example, if samples
500-800 of the buffer are empty when a
sample in this Mode is loaded, samples 500-
800 of the new sample will go into the empty
space.  If some or all of that is silence in the
new sample, that will be loaded as well.

º Mask. This is the inverse of Insert.  The
entire new sample will be loaded, but any
silences that may be in the sample will not
erase what was already in the buffer.  New
samples will replace old samples, but silences
will leave old samples untouched.

X Clear buffer.  All samples in the entire Sample
Buffer will be cleared.

Playback Quality

To the far right of the Preset window is the Preset Options
column.  This will effect the quality of playback of the Preset.
It is possible to select between two different sample rates for
playback, Good and Best.  Presets assigned to Good will play
back their samples at a rate of 22.05 kHz, and Best at 44.1
kHz.  It is also possible to enable or disable sample
recording.  When sample recording is disabled, more voices
will be available, especially on slower machines.  If a Preset
is record-disabled, the Record indicator in the Status window
will have red cross-hatching in it.

Clicking on the four-letter code of a Preset will reveal a popup
menu with 4 options:

ErGp  Enabled Record, Good Playback

ErBp  Enabled Record, Best Playback

DrGp  Disabled Record, Good Playback

DrBp Disabled Record, Best Playback
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Changing Presets via MIDI

To change a Preset via MIDI, you must send LiSa a Program
Change message on the channel you have selected as LiSa’s
System Channel in the System Settings Dialog (see p. 16).
The program change number +1 will be the Preset you call up
(pgc 0 = Preset 1, etc.).

Stop Notes on Preset Change Option: When this is checked (in
the Options menu), all currently active notes will be silenced,
and all Control values that you have changed while using the
Preset will be set back to their original values.  If it is not
selected, all active Zones will remain active until turned off,
and returning to that Preset, you will find all of the controllers
in their last position before you changed Presets.  If you are
switching between Good and Best playback quality, all notes
will always be stopped.

Setups
A Setup is the actual file you save when you select Save in
the File menu, and is the file you load or open from the New
Setup... or Open Setup...  File menu items.  It is comprised of:

•  All the Presets you have written for that Setup.
•  The preferences you have set in the Global menu.  Each

Setup can have its own System Settings, buffer sizes, and
pitch bend range.

•  All selected Options in the Options menu, except for Show
Current Sample Pointer, which always reverts to on.

•  Pointers to Libraries.  All data structures such as Zones and
Tables, which are stored in Libraries, are stored in
separate files, and the Setup remembers which Libraries
to open up with the Setup.

Libraries
All data structures in LiSa are created and stored in a Library.
Seven Libraries contain all of the data structures used in
LiSa: Zones, Patterns, Envelopes, Tables, Controllers,
Samples, and Parameters.  These are separate files from
your Setup file -- any number of Setups can share Libraries.
They are saved in the same folder as your Setup file, and are
automatically named with the name of your Setup plus the
type of Library.  (For example, if your Setup is called Foo,
upon saving it LiSa will create Library files named ‘Foo

Changing your current
Preset via MIDI (since it is

primarily designed for
performance) will not give
you the option of storing

any changes in your
Preset.  When editing, it is
thus advisable to switch
Presets from the user

interface.
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Envelopes’, ‘Foo Controllers’, etc.)  Once created, Libraries
may be saved in any location on your hard drive – they need
not be in the same folder as their original Setup.  LiSa will
remember their access path as long as they remain on the
volume on which they were created.  All standard Macintosh
edit functions work in Libraries – Items in Libraries can be
duplicated, cleared, etc. via the Edit menu.  Some Libraries
exhibit slightly differing behaviors, which are mentioned in
their specific sections.  The explanations below apply to all
Libraries, whatever their type.  The one exception is the
Parameter Library, which is not changeable, and simply
provides a list of the control parameters available.  For use of
the Parameter Library, see Parameters and Controllers on p.
89.

Library Functions

•  Creating new data structures.  All Zones, Controllers, etc.
are created by using the New button in the library window
of that type.  Some of these structures may also be
created in other ways as well, but they can all be created
from Libraries.

•  Managing data so it can be used by multiple Setups.  As
mentioned above, multiple Setups may share Libraries.

•  Reference for what structures have been created, and
whether they are used in a Setup.  (The exception to this
is the Parameter Library, which indicates the used
Parameters in each Voice Layer, not Setup.)

•  Drag-and-drop of data into a Preset.  An item from any
Library can be dragged to an appropriate numerical or
menu item.  For example, any table may be dragged to a
CTab numerical in a Zone Editor Window, and samples in
the Sample Library may be dragged directly into the
Sample Buffer or the Sample Editor.

Loading Libraries

To load an existing Library into an open Setup, select Load
Library... from the File menu.  This will bring up the standard
Open File dialog box.  Once you have selected a file to load,
you will be presented with a dialog box asking if you want to
replace the current Library, or append the Library you are
loading to it.  Selecting Append will add the Tables,
Envelopes, or whatever, to the end of the current Library of
that type.  Selecting Replace will delete whatever was in
there previously.  When you select Append, the current
Library will keep its original name.  Selecting Replace loads in
the new Library, name and all, into your Preset.  All of these
operations can be performed while the Library windows are
open or closed. If you Load items into or Save As... a closed
Library you will see the results when you open it.

When loading a set of old
Libraries into a new Setup, it is
best to load the Zone Library

last.  If the Zones have
pointers to patterns or

envelopes in a Library that
isn’t loaded yet, those pointers

will be lost.
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Saving Libraries

You can save a Library independent of the Setup at any time
by selecting Save Library as...  from the File menu.  You will
see a slightly modified dialog box, like the one at left.  When
saving, you should select the radio button with the correct
type of Library, or LiSa will not be able to load it properly.
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SSSSoooouuuunnnndddd    MMMMaaaannnnaaaaggggeeeemmmmeeeennnntttt
This chapter describes how to handle samples that are
already on disk or in LiSa’s buffers.  For information about
how to record samples directly into LiSa live, see the chapter
Recording a Sample on p. 69.

The Sample Library
The Sample Library does not actually contain any samples.
Rather, it is a list of pointers to a set of the soundfiles on your
hard drive.  These samples do not need to be in any
particular location on your drive, or even on the same volume.
Once in a Library, as long as the sample remains on the
same volume, LiSa will be able to find it.

LiSa can load samples
recorded in either Sound

Designer II or AIFF format,
16-bit, with a sample rate of
44.1 kHz.  It saves recorded
samples as SDII mono files.
It can open stereo files, but
it will force them to mono,

possibly causing unwanted
phase interference, so we
recommend that if you are

using files you’ve previously
edited or processed, use

mono files.
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Building a Sample Library

There are two ways to build a sample Library:

Click on the Add button.  It will bring up a dialog in
from you can add soundfiles to the Library,
either individually or by the folderful.

Click on the Scan button.  If you have multiple drives
on your system, it will present a popup menu
from which you can choose a drive.  Once the
drive is selected, LiSa will scan the drive for all
readable soundfiles and add them to the
Library.

Drag selections from the Sample Editor over to the
Sample Library, which will automatically save
them to disk.

Editing the Sample Library

Once there are samples in the Library, the list can be sorted
either alphabetically or by length, depending which option is
selected in the lower left corner.  A sample used in a Preset,
either in the currently active Zone Library, or as a Preset
Sample Load, will have a bullet next to its name.

Other commands:

Info.  Clicking on this button will present a box
showing the filepath of the selected sample.
The box will remain visible only as long as the
mouse button is held down.

Play.  Activating this button will play the selected
soundfile.  Clicking it again will stop playing.
Double-clicking on any sample name will also
play the sample.

Name.  Clicking on this will bring up a dialog in which
you can rename the sample.  This is identical
to changing the name in the Finder.

Trash.  Puts the selected soundfile in the Trash.  It is
not an immediate delete – the Trash must be
emptied for the soundfile to be permanently
thrown out.

Clear   (from Edit menu).  Selected samples will be
cleared from the Library, but remain untouched
on your hard drive.  The Sample Library must
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be the topmost window for this command to
work.

Other Soundfile Options

Samples can be moved around on your hard drive directly
from LiSa.  There are two ways to do this:

The Load Sample… dialog box (available from the File
Menu) presents other sample management
options:

Rename .  Obviously enough, you can rename a
selected sample.  Click on this button and
another dialog will appear prompting you to
enter a new name.

Move .  Selecting Move will  put the selectede
soundfile in a new folder inside the same folder
as your setup entitled Moved Samples.  You
can then move these samples where you will in
the Finder.  (If you move these samples onto
another disk or partition, the Sample Library
will lose track of them.)

Delete .  This should be fairly clear. You will get a
dialog box asking for confirmation that you
want to delete the soundfile.  Don’t try getting it
back.

The Sample Buffer
The Sample Buffer is the section of RAM allotted to LiSa in
which playable sounds actually live.  (For the basics of this,
see Sound in the Computer, page 5).  When editing a Setup,
there are two access points into the Sample Buffer: the
Sample Buffer pane of the Status window, and the Sample
Editor.

You cannot use any of
these methods to move

soundfiles from one hard
disk or partition to another.

To Zoom your view of
the sample Buffer I the

Status window, highlight
part of the zoom pane

directly above the
Sample Buffer window.
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Loading Samples into the

Sample Buffer

There are several ways of loading samples into the Sample
Buffer.  All of these methods are pastes, not inserts, and will
overwrite any previously loaded samples in the chosen
location:

Select Load Sample… from the File Menu.  This will load
a sample into the Sample Buffer, starting from
the beginning of the buffer.  Note that this is
the one method you can use to load samples
that are not in the Sample Library.

Dragging a sample name from the Sample Library to other
windows will also load samples into the buffer, in several
different ways:

To a Playback Zone in the Zone Editor: As much of
the sample as will fit into the Zone’s region will
be loaded, wherever it is in the buffer.

To the virtual keyboard: The sample will be loaded
into the buffer immediately to the right of the
rightmost loaded sample, or at the beginning of
the buffer if empty.  In addition, a new
Playback Zone, with the same name as the
sample, will automatically be created.

When dragged to either the Sample Buffer pane of the Status
window, or into the Sample Editor,  modifier keys control the
exact way you can locate the sample:

With no modifiers, the sample will automatically start
from the beginning of the buffer.

Option-drag will automatically place the sample after
the last sample in the buffer.

Cmd-drag allows you to place the sample in a specific
location in the buffer.  Once you drag the
sample over the Sample Buffer pane, a
number box will appear which will show you
the exact location of the sample in the buffer.
In the Sample Editor, you can place your
sample visually.

When dragging samples to the buffer, a message will
appear in the System Messages pane of the Status
window to remind you of your current dragging mode.



38

Saving samples from the

Sample Buffer

There are two ways of saving all or part of the Sample Buffer
to your hard disk as a new sample.  Both of these methods
will automatically add the new sample to the Sample Library:

Select the Save Sample Buffer... item from the File
menu.  This will give you the option of saving
either the entire Sample Buffer or only the
current visible zoom as a SDII file.  Current
visible Zoom refers to the visible area of the
Sample Buffer as shown in the Sample Buffer
pane of the Status window, and not to the
Sample Editor window.  You set the Zoom in
the Status window by click-dragging over the
desired section of the buffer in the Overview
Pane of the Status Window.

 Highlight the region you want to save in the Sample
Editor window.  A grabbing hand icon will
appear when the cursor is over the highlighted
area.  You can then drag it to the Sample
Library, where you will get a standard Save
File dialog box.  Dragging it to the Preset
window will also save the sample, which will be
loaded together with the Preset.
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The Sample Editor

Version 2.0 of LiSa has added a Sample Editor window to
simplify working in the Sample Buffer.  Some of the features
formerly included in the Sample Buffer pane of the Status
Window have been moved to the Sample Editor, and many
new features have been added.

Overview

The Sample Editor window contains an exact reflection of the
sounds in the Sample Buffer.  Changes made in one window
are immediately reflected in the other.  As the editor is only
reflecting what is in RAM, any edits made in the Sample
Editor have no effect on any soundfiles on disk.  The entire
buffer, or any part of it, may be added to the Sample Library
and saved to disk.  Unlike LiSa’s other windows, it can be
resized, by click-dragging any of the three shaded corners.

Navigation

The Sample Editor provides two views of the buffer: The Edit
pane, and a smaller overview below.  The Edit pane can be
zoomed in and out from the overview, which always shows
the entire contents of the Sample Buffer.  The part of the

New in Version 2.0
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buffer visible in the Edit window is always shown in the
Overview pane in red.  In addition, the top row of numbers,
labeled Current Zoom, will show the exact start point, end
point, and duration of the area visible in the Edit window.  To
change the view in the Edit window, click-drag on the
overview:

Vertical dragging up or down will zoom in or out of a
specific section of the buffer.  Note that when
you zoom in or out, expansion or contraction of
the visible area is from a fixed start point on
the left.

Horizontal dragging will move the visible area to the
left or right in the buffer.  The red area in the
Overview will move with the cursor.  To fine-
tune a location, shift-dragging will move the
view at a much slower rate.  Clicking in the
overview will immediately move the area
visible in the Edit window to that location.

There are also two types of buttons to aid changing views:

Expand Selection.  Clicking on this button will cause
the selected area to completely fill the Editor
window.

Snapshots.  The four numbered buttons on the
Sample Editor, called Snapshot buttons, serve
as view memories.  Shift-Clicking on one of
these buttons will remember the location and
zoom view of that portion of the Sample Buffer,
and a normal click will return the Edit window
to that view.  Snapshots are not remembered
after you quit LiSa.

Appearance

The waveform in the Edit window will also appear in as many
as three colors:

•  Black, for unselected areas.
•  The sample region of the current Zone will appear in that

Zone’s color.  This will also be visible in the Status
window.

•  The selected area will appear in your computer’s ‘highlight’
color.
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Playback

To start or stop playing in the Sample Buffer, press the
spacebar.  You will hear the sound beginning at the current
cursor location.  If you have selected part of the buffer, the
highlighted area will automatically be looped.  If nothing is
selected, the area currently visible in the Edit window will be
looped.  (The selected area will take priority over visibility, so
if a selected area is partially or entirely invisible, you will still
hear it.)

Editing

Selecting

To select a portion of the buffer, click-drag with the mouse.
Shift-clicking will extend the selection.  The highlighted area
can also be fine-tuned with the Arrow keys:

 Option-left arrow and Option-right arrow will nudge
the left-hand edge of the selected area.

 Option-up arrow and Option-down arrow will nudge
the right-hand edge to the right and left,
respectively.

The nudge size is 1 kB of samples (1024 samples, or about
.023 of a second).  Once a selection is made, its exact start
point, end point, and duration will be displayed at the tip of
the window, in the row labeled Selection .

Edit functions

Some of the standard Edit menu items are also available from
icons in the Sample Editor:

Cut will remove the selection, put it on the clipboard,
and move all samples to the right of the
selection to fill in the empty space.

Copy copies the selection to the clipboard, leaving the
original untouched.

Paste will insert the sound on the clipboard at the
insertion point, moving all sounds to the right.
If paste is used when a region of the Sample

For playback and editing
functions to work, the

Sample Editor must be the
topmost window.

Once an area is selected,
clicking in it will produce

the grabbing hand cursor,
which is intended for

dragging the selection to
the Sample Library.  To
get the regular cursor
inside a selected area,

Option-click.
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Buffer is selected, it will replace whatever is in
that region.

Clear (Available in the Edit menu only) will replace the
selection with silence.

Undo is not available In the Sample Editor.

Special Functions

Normalize.  This normalizes the selected area of the
Sample Buffer.  This effects only the buffer,
and samples on disk are left untouched.  This
is also available in the Edit menu, or by
pressing Cmd-M.  This is a non-real time
option, so it’s not recommended for live use.
Normalization will take your sound’s loudest
sample and make it equal to 0 dB, thus utilizing
the full 16-bit audio range available.

Save Sample to Disk.  You can drag any selected
area of the Sample Editor to either the Sample
Library or the Preset Window.  If dragged to a
Preset, that sample will be automatically
loaded when that Preset is called up.

Enter Selection in Zone.  This item, available in the Edit
menu, will automatically set the Start and
Length parameters of the Zone currently in the
Zone Editor to that of the current Selection.

Enter Region in Zone.  If you change the size of the
current Zone via MIDI, selecting this from the
Edit menu will automatically resize the default
sample region to the current one.
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TTTTaaaabbbblllleeeessss    aaaannnndddd
EEEEnnnnvvvveeeellllooooppppeeeessss
There are two data structures in LiSa which serve multiple
functions in different contexts: Tables and Envelopes.  This
chapter contains basic information on both of these
structures, and will briefly mention their applications in
different aspects of LiSa.  Their use in particular contexts is
explained in full in the relevant chapters.

Tables
This section covers general editing and handling of tables.

•  For tables used to modify parameter controls, see Mapping
MIDI Controllers – CTabs on p. 97.

•   For tables used to generate sound, see Wavetable Zones
on p. 58.

•  For editing tables in real time, see Real-time Control of
Tables on p. 98.

Creating a new Table

Like all other data, tables are stored in a Library.  The Table
Library window works identically to all other Libraries.

There are two ways to create a new table:

Click on New in the Table Library window.

Select the New Table menu item from any of
the popup menus labeled CTab in the Zone
Editor.

This will immediately open the Table Editor window,
with a new table full of random values.  A single
Library can hold up to 256 tables.  Each new table’s
name will appear in both the Table Library and the
CTab popup menus in the Zone Editor.
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The Table Editor

The top row of the Table Editor has the usual LiSa
identification number (you can change the table you are
editing by scrolling through this numerical or using the right
and left arrow keys when this window is topmost) and name
field.  There is also a third numerical to control the table’s size
(domain).  Default (and maximum) is 512.  Note that the Y
values are stored in the table as floating-point numbers,
which are truncated for MIDI.

The Table Editor window can be viewed in two ways:
graphically (the default) and numerically.  You can toggle
between these two views by clicking on the radio buttons
marked with a pencil or the numeral 2 on the right-hand side
of the window.  These two views reflect the same information,
but each view has slightly different editing capacities.  Tables
can be drawn, edited number-by-number, generated using
the Function buttons, or copied directly from the Sample
Editor.

Graphics view

In this view, one can simply draw the desired curve into the
Editor window.  The X and Y values of the cursor are shown
in the location box at the bottom center of the editor.

Numerical View

In this view, the table is represented as one or more pages of
128 numericals.  Each numerical shows the Y value for an X
value that corresponds to its position in the table, ranging
from zero to the domain of the table.  Putting the cursor over

New in Version 2.0:
graphical Table

editing
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a numerical will show its X and Y values in the location box at
the bottom center of the table.  You can only see 128 values
at a time in this view – to go to higher or lower ranges, click
on the boxes with the triangles on the lower left and right of
the Editor window.

To edit in numerical view, scroll the numerical corresponding
to the X value you want to change to it’s desired value, or
type the value in.  Only integer values may be entered from
the numericals.  (It is handy to have your highlighting color
set to something other than black -- it makes it much easier to
see what is happening in the tables.)

Function Buttons

LiSa has two types of function buttons.  Some put in a
standard set of values, and some allow you to set certain
parameters and apply a function to them.

SSSSeeeetttt    ffffuuuunnnnccccttttiiiioooonnnnssss

These buttons will always exhibit the same behavior,
adjusting to the size of the table.  Minimum and maximum
values cannot be scaled, and are always from 0 to 127.

Linear.  This button creates a linear table, with Y
values beginning at 0, and reaching 127 at the
maximum X value of the table.

Reverse Linear.  This loads the exact inverse of the
above table, with the lowest value of X being
equal to 127, and the highest 0.

Triangle.  Maps a triangle wave beginning and ending
with zero to the full domain of the table.

VVVVaaaarrrriiiiaaaabbbblllleeee    ffffuuuunnnnccccttttiiiioooonnnnssss

You can create several line segments or random ranges
using the Variable Function buttons.  These work only in
numerical view, where you can set as many breakpoints as
you like.

Line Segment.  In Numerical view, you can make any
number of breakpoint line segments.  Shift-
clicking on a numerical in the Table Editor will
select it.  You can select any number of
numericals by shift-clicking.  When you set the
selected numericals to values of your choice
and click on this button, LiSa will automatically
interpolate a line segment between pairs of the
selected numericals, as seen below.

Floating-point table values
will appear in Bold in the

numerical view.  There are
no dual numericals in the

numerical view – you must
set floating-point values
from the graphics view.
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If no numericals are selected, and you click on Line
Segment, it will automatically interpolate a line from
the first to the last value in the visible page of the
table.  To create a table with more breakpoint line
segments, you have to have at least two numericals
selected.

Note in the example that the region
from the last selected numerical
(containing 90) to the end of the
table is not a line segment from 90
to 0.  This is because the last
numerical was not selected.  If you
only select a segment inside the
boundaries of the table, as in this
case, the portion of the table from
the selected numerical closest to
the boundary of the table will
remain untouched.  What you see
in this case is what remained from a
previous table – a triangle wave.
You can use this to combine line
segments with other kinds of
functions.  Although all of the line
segments in this table are of linear
values, you can interpolate between
any two numbers using this system.

Random.  This function works very similarly to the
Line Segment function.  Clicking on this button
with no numericals selected will create a flat
random distribution in the range 0-127.  By
selecting pairs of numericals the same way as
line segments, and clicking on this button, you
can create a random distribution within the
limits set by the selected numericals.  When
creating these ‘segments’ of limited random
distribution, the numericals that start and end
the region may change when you click the
button, as they are included as part of the
random distribution.  As with line segments,
you can create as many regions of different
distributions within one table as you wish.
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Using variable functions with large tables

When using a table in numerical view, you can see only one
128-number page of it at a time.  If you want to make a longer
series of line segments, you can repeat the procedure on
each page of the table.  Only the visible page of the table
changes when you use a Variable Function button.

Copying from the Sample Editor

You can copy data directly from the Sample Editor and paste
it into a table.  (Only the first 512 samples of your selection
will be used.)  Particularly useful when using a table as a
Wavetable (see Wavetable Zones on p. 58), this technique
will work if the table is in either graphic or numerical view.
There are two ways to do this:

Copy and Paste.  Bring the Sample editor window to
the front.  Make your selection, and copy it to
the clipboard.  Bring the Table Editor to the
front.  Select Paste from the Edit menu, or type
Cmd-v.  The selected portion of the waveform
will appear in the table.

Select and Drag.  You can click-drag any highlighted
area from the Sample Editor directly into the Table
editor.

Envelopes
Only general handling of envelopes is covered here.  Specific
applications of envelopes are covered in their respective
sections:

•  For Amplitude control, see Amplitude Envelopes on p. 61.
•  For Filter control, see

Although line segments
often appear to hold the

same value (note the
repeated numbers in the first

segment on the previous
page), they are stored in

LiSa as floating point
numbers, not integers.  This
means that although there

may be no visible difference
between two adjacent

numbers in the Table Editor,
these two values may well

sound different when used to
control playback.  If a
number is stored as a

floating point number, it will
appear in the Table Editor in
bold.  If you want a table to
have a consistent value for a

certain number of steps,
your line segments must

begin and end on the exact
same value.
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Filters on p. 62.

•  For Wavetable mixing, see Wavetable Zones on p. 58.

Envelopes in Setups

Envelopes are stored in and accessed from an Envelope
Library.  You can change the amplitude envelope of a Zone
by sending it MIDI, using the Envelope Select parameter (p.
94). Default is to envelope No. 1.

Creating and editing

envelopes

To make a new envelope, you can either:

Click on the New button in the Envelope Library
window (available in the Windows menu, or by
typing Cmd-4.).

Click on the Val numerical next to the Env
parameter in the Zone Editor.  A popup menu
of all available Envelopes will appear, together
with options for creating a new Envelope or
editing the current one.

They are edited in the Envelope Editor, which is also
available in the Windows menu, or by double-clicking on an
envelope in the Envelope Library.  You can cycle through
available Envelopes in the Envelopes editor by using the left
and right arrow keys.

Envelopes in LiSa are basic ADSR envelopes.  They contain
4 stages; each scaled from 0 to 99, except Sustain, which is
scaled from 0-100.  Lower values mean shorter time
durations.

Attack .  The time it takes the envelope to reach its
maximum value.
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Decay .  The time it takes to go from full value to the
sustain level.

Sustain .  The value of the envelope after it has
passed the decay stage.  It will remain at this
value as long as the Zone is active.  Note that
this is not a duration.

Release .  The time it takes after the Zone is
deactivated (your finger is off the key) for the
envelope to return to zero from the Sustain
value.
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PPPPllllaaaayyyyiiiinnnngggg    BBBBaaaacccckkkk    aaaa
SSSSaaaammmmpppplllleeee

Once you have sound in the buffer, there are a great variety
of playback methods for sampled sounds.  All of these are
done with Playback Zones.  The exact way in which the
playback works is determined by the mode of the Zone.  In
this section we will look at these possibilities in detail.

Defining a Zone
The process for defining a Playback Zone, like all Zones, is
comprised of 5 parts:

•  Creating a new Zone in the Zone Library window.
•  Assigning the Zone to an activation key or keyrange in the

Assignment window.

•  Assigning a sample region to the Zone, in the Zone Editor
or the Sample Editor.

•  Defining the Zone’s functions in the Zone Editor.
•  Creating Parameter Control variables for the Zone, if

desired.  This happens in both the Zone Editor and the
Assignment window, and will be discussed in full in the
chapter Parameter Control  on p. 86.

The order you do these in is of no particular importance
(though it helps to create the Zone first), and you can freely
readjust any parameter at any time.
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Creating the Zone
The first step is to create a Playback Zone and assign it to a
keyrange on the virtual keyboard in the Assignment window.
Click on New in the Zone Library window, and a new Zone
will appear.  Assign it to a keyrange by clicking on the Zone
name and dragging it to the virtual keyboard.  When defining
the range for your playback Zone, remember that it is in
Playback Zones (and in Playback Zones only) that the
location of the Zone on the keyboard is related to the pitch of
the sound you hear.

Defining the Sample
Region
The numericals in the Region pane of the Zone Editor define
the sample region of the Zone (the part of the sample buffer it
acts on) and set the Zone’s playback pitch.  Please note that
all of these parameters can be controlled via MIDI, and are
amongst those most often used in LiSa.

Stt   (absolute region start).  Sets the absolute start
time of the Zone’s region – the segment of the
Sample Buffer from which the Zone will access
sample data.  This numerical will always have
a minimum of 0.  The maximum depends on
the amount of memory you have allotted to the
Sample Buffer.  This is an absolute offset --
MIDI controls can only make the region go
above (to the right in the buffer) this position,
not below.

Len    (length).  Sets the length of the Zone’s sample
region.  Minimum is 1 kB of samples (± 0.023
seconds) and maximum is from the start time
to the end of the buffer.  Default is 5.00
seconds.

When setting these two
parameters, Len  takes

precedence over Stt .  That
is to say in a 10-second
buffer, if Len is set to 3

seconds, Stt will
automatically not go past 7
seconds.  However, when

controlling the location of the
Record Zone via MIDI, You

may wind up playing past the
section or RAM allotted to

LiSa.
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Mvr  (movement range).  This numerical is used to
define the effects of MIDI data sent to the
above parameters.  When this value is set to 0,
MIDI sent to the Stt  parameter will have no
effect.  Set to maximum (again, automatically
the length of the buffer), the full range of a
MIDI controller (0-127) will cover the full range
of the buffer.  If set to half the length of the
buffer, it will cover half the length.  Default is
the entire length of the buffer.

You will notice that we are ignoring the CTab popup menus.
These are related to how their variables interpret MIDI
information, and will be discussed at length in Mapping MIDI
Controllers – CTabs on p. 97.

Quick Zone Creation

In many cases, you will want a Playback Zone to simply
correspond to one sample in the buffer.  There is a fast
system for creating such Zones, combining keyboard
assignment, buffer region, and transposition in one simple
gesture.

Drag a sample from the Sample Library directly to the
Virtual Keyboard in the Assignment Window,
and assign a keyrange.  This will automatically:

•  Create a new Playback Zone, with the same name as the
sample.

•  Load the soundfile into the Sample Buffer, immediately after
the last sample in the buffer.

•  Set the sample region to the exact size and location of the
sample.

•  Set the Tun  parameter so that the leftmost key in the
keyrange selected will play back the original pitch of the
sample (tuned for a chromatic keyboard).

It is possible, by dragging samples larger than your buffer,
to actually create Zones larger than your buffer size.  This
can cause problems, and after saving and restarting such
a Setup, you may receive a warning dialog when loading.
You should check out your Zone sizes or resize your
buffer (p. 15) before proceeding.
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Pitch
Pitch transposition of sampled sounds is one of the most
common uses of samplers.  LiSa gives you full control over
your playback pitch, including the ability to implement non-
equal tempered scales.  The pitch of a Playback Zone can be
altered in two ways:

•  By changing the Tun  value in the Region pane of the Zone
Editor.

•  By playing it back on different MIDI notes in its keyrange.

Initial Pitch

To change the note number that will play the sample back at
initial pitch, you adjust the Tun  numerical in the Region pane
of the Zone Editor.  When you record a sample, LiSa will
default to playing it back at its initial pitch at note 60(c3)  (We
call this the initial pitch of a note, regardless of what it’s pitch
is in the real world, or even if it has no pitch at all).  Thus, in a
Playback Zone that begins at note 72(c4), the lowest it will be
able to play a sample will be one octave above the sample’s
initial pitch.

This numerical has a range of -60 to 60, measured in half-
steps, which allows you to adjust the initial pitch of the Zone
over a 10-octave range, centered on note 60 (c3).  This is a
dual numerical: by pressing the shift key, you can fine-tune
the initial by plus or minus 99 cents (1/100 of a half-step).  If
the tuning in cents is anything other than zero, the coarse-
tuning value will appear in bold.

Keyboard transposing

The playback pitch of the Zone will be relative to the initial
pitch you have set in Tun.  A Zone with a Tun  value of -12
will play back a sample on key 60(c3) at a pitch one octave
lower than its original pitch -- the effective playback pitch will
be 48(c2).  With a combination of Tun  and your keyrange,
you can play back the sample in any transposition or possible
sets of transpositions you desire.

Scale Retuning

Default tuning for the virtual keyboard is 12-tone equal
tempered.  It is possible that you may want to use a different
scale.  You may want to implement just or microtonal tunings,
or have the keyboard tuned in some completely nonscalar
way.  This can be easily implemented in LiSa.  Look at the
Assignment window and press the Caps Lock key.  The
virtual keyboard will change into this:

When tuning a sample
from this numerical, you
will only hear the new

pitch when you trigger the
sample again.  (This is not

true, by the way, when
you alter Tun  via MIDI).

Remember, Tun sets the
initial pitch of the Zone,

not the sample itself.  It is
possible to have any

number of Zones with the
same region (i.e., playing
back the same sample),
each with a different Tun

setting).
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This is a representation of one octave of the virtual keyboard
(notes 61-72, d3-c4).  The note numbers are shown on the
lowest row.  As with the normal keyboard, you can view
above or below this octave by clicking on the arrow buttons to
the right and left.  Above the note numbers are a set of
numericals representing the pitch value of each note,
expressed in cents.  Each of these numericals has a range of
0-12000, thus making it possible for each MIDI note to play at
any pitch within LiSa’s entire range.  The virtual keyboard for
each Voice Layer can be tuned separately.  These pitch
tables are stored at the Preset level, meaning that each
Preset can hold 16 pitch tables, one for each Voice Layer.

Preset Tunings

There are a few keyboard shortcuts for the most common
tunings.  Hitting these keys at any time will tune the virtual
keyboard for the currently selected MIDI channel.  These are
not Cmd-key combinations.  A dialog will appear asking for
confirmation that you in fact want to retune the keyboard.
The available shortcuts are:

•  N = normal; 12-tone equal tempered.
•  K = quarter-tone equal tempered scale; two MIDI notes to

the half-step.

•  U = unison; all notes play back at note 60(c3).

The keyboard will not
switch back into normal
mode (keyrange setting
mode) if the cursor is in

one of the tuning
numericals.
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The Play Treatment Pane
The variables appearing in this pane control the basics of
playback.  All of these parameters are MIDI-controllable.

Lev  (level).  This numerical controls the overall level
of the Zone’s output.  This parameter is always
linked to the velocity of the played note, so that
a velocity of 127 will output the value shown in
this numerical.  (For more on this, see Velocity
Mapping, p. 100.)  Maximum is 100 (100% of
the original level of the sample), and minimum
is 0.  Default is 100.

Pan (panning).  This controls the location of the
sounds in a stereo field.  The range is from
-100 (hard left) to 100 (hard right).  0 is center.
The exact behavior of Pan when used with live
MIDI is dependent on the type of controller
used.  For more information, see Channel and
Voice MIDI Control, p. 91.

Env  (envelope) A popup menu which selects between
available amplitude envelopes.  It is possible to
change the envelope via MIDI control – see the
Output Parameters section of the Parameter
menu, p. 94.

In addition, in the lower-right corner of this pane are
the special parameters, unique to each mode, and will
be described below with the playback modes.

Defining the Zone’s

Function
The Zone you have just created should be visible in the Zone
Editor window.  The Zone’s function is defined from Function
icon, the leftmost one in the Editor window.  (For more, see
Zone Functions, p. 25.)  The default function for new Zones is
Playback, so you are ready to start setting its modes.
Different modes will also change the parameters available in
the Play Treatment pane, so we’ll be jumping back and forth
a bit between the two.  The bottom right numerical in the Play
Treatment pane is the one which changes the most
depending on the playback mode; this is called the special
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parameter numerical, and all references to special
parameters below refer to this numerical.

Defining the Zone’s
Modes
The Playback Mode menu, the leftmost of the Function
buttons, determines the basic ways the Zone reads the
information in its sample region.  It covers things like the
direction (or directions) the Sample Buffer is read, and also

includes some secondary processing (effects) options.
Generally, listening to them will make their function
more clear to you than the descriptions below, so we
encourage you to experiment with the program as you
read.

Forward (default).  This simply plays the sample
region from beginning to end, with no secondary
processing.

Backward.  As above, but playing from the end
of the region towards the beginning.

Back and Forth.  In this mode, the Zone’s region
is read first forwards and then backwards upon
reaching the end.  A Zone in this mode and in
Once or Trigger mode (see below) will play the
region once forwards and once backwards
before coming to a stop.

The Fuz Parameter.  In the Play Treatment pane,
these three modes all have the special parameter
Fuz, which is a distortion algorithm.  When set to 0,
there is no distortion.  As the value of this parameter
increases, so does the distortion.  The louder the initial
sample, the faster distortion will occur.  This, like all
distortions in the Sample Buffer, is an analog-type
distortion, and will not create nasty digital clipping.

Spiral Algorithm.  The exact operation of this algorithm is a
trade secret -- you just have to listen to it and see what it
sounds like.  Its special parameter is called Spiralness, or Spl
in the Play Treatment pane.  It’s a non-linear parameter -- you
just have to try it out!  Range: 1-256, default 64.

  Pattern Mode Rough.

  Pattern Mode Smooth.  The Pattern modes are one of
LiSa’s most powerful playback options, and are
complex enough to merit a chapter of their
own.  To learn more, see
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Pattern Mode, p. 63.

  Autopan.  In this mode, the Pan control numerical is
disabled, and there is no special parameter.
Zones in this mode play a sample forwards,
and automatically pan it from left to right,
starting left and going to the right once every
time it reads through the region, and then back
again from right to left.  This means that the
pan rate is dependent on the pitch and length
of the region: the higher the pitch and the
shorter the sample, the faster it will pan.

Scrub.  This is LiSa’s attempt at commercial success
with the hiphop crowd.  It uses the Scb
parameter.  With an initial value of 64, you will
hear no sound.  This is because the sample is
not ‘moving.’  As you increase the values
above 64, you will hear the sample looping in a
forward direction, starting very low, and
increasing in pitch as the control value goes
up.  As you go below 64, the same thing will
happen, except the sample will go backwards.
At a value of 72 (forwards and default) or 56
(backwards) the sample plays at its original
pitch.  It responds to MIDI values exactly the
same way.  The total pitch range covered is
from as slow as possible to 4 octaves above
unbent pitch.  This is most useful when
connected to the Pitchbend parameter of your
keyboard -- it’s already centered at a control
value of 64.

Resonator.  The Resonator uses a combination of
delay and feedback to emphasize the upper
harmonics of a sound.  By adding the sample
to itself with a slight delay, resonances are
created.  Playing with it is also the best way to
get the hang of what happens when you
change the special parameters.  This mode
has two special parameters, which may be
toggled by holding down the shift key.

Res (resonance frequency).  This controls the
emphasized frequencies.  Range is from 0-127,
default is 64.

Dpt  (resonance depth).  This controls the amount of
the sample that is fed back.  The resonance value can
be either positive or negative, but as it is mapped to
MIDI, 64 is equal to 0.  At 64, no resonance will occur.
As you increase the resonance depth in either
direction, you will increase the strength of the upper
harmonics, but with different timbral results depending

When you are playing in
Step mode (see below)

your pan position will take
up from where you left off
the last time you activated

the Zone.  In Restart mode,
it always starts from the left

and heads to the right.

The Scrub mode will only
work well in conjunction
with the Looping mode
(see the Activate Mode

menu below)
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on whether your value is above or below 64.  Range is
0-127, default is 64.

Wavetable Zones

Although this mode appears with the playback modes, it
differs from them in that it does not read samples from the
Sample Buffer.  Instead, it reads from tables.  (For a general
discussion of tables, see Tables on p. 43).  Wavetable
Synthesis is a technique that uses a set of numbers stored in
a table as if it were one cycle of a repeating waveform,
turning the table into a lookup oscillator.  By reading the
tables at different rates, one changes the pitch of the
oscillator.  The exact timbre of the sound produced will
depend on the shape of the wave inside the table.  Wavetable
Zones in LiSa use two tables, which can be modulated
together.  The only special parameter in the Play Treatment
pane is Fuz (see above), and the Region pane changes
entirely, becoming the Wave pane.

TTTThhhheeee    WWWWaaaavvvveeee    PPPPaaaannnneeee

As you can see, all the numericals, except for
Tun , now have different names.  Since
Wavetable Zones don’t read from the Sample
Buffer, Stt  and Len  are no longer needed.
In the Wave pane, you choose two
waveforms to use, and select an envelope
that will determine their relative balance.

Src  (source).  Clicking on this numerical will present a
popup menu of the available tables, or give
you an option to make a new one.  The table
you select here will be the first waveform heard
when you activate the Zone, or the Source
wave.

Dst  (destination).  This works identically to the Src
parameter.  The table chosen here, the
Destination wave, will be averaged with the
Source wave, in a proportion determined by
the selected Env .

Env   In this numerical, you select an envelope which
will determine the timing and ratio of the two
wavetables.  In a Wavetable Zone, an
envelope functions somewhat differently than it
does when used to control amplitude.  When
the Zone is first activated, you will hear 100%
of the Source wave.  Over a period of time
determined by the attack length of the
envelope, the Destination wave will be added

New in Version 2.0
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to the source, until at the end of the attack, you
will hear 100% of the destination wave.  The
Decay time will determine the period it takes to
reach the Sustain level.  This is not a volume
level, but a ratio setting between the two
waves.  When Sustain is set to 0, you will hear
only the Source wave.  At 100, only the
Destination.  Values in between will give you a
mixture of the two waves.  Release time will
determine the rate at which you return to
hearing 100% of the Source wave.

UUUUssssiiiinnnngggg    CCCCTTTTaaaabbbbssss    aaaassss    wwwwaaaavvvveeeettttaaaabbbblllleeeessss

When using a Playback Zone in Wavetable mode, LiSa is
treating the chosen tables as lookup oscillators.  This means
that the tables used are treated like very small sample
buffers, and the shape of the table is effectively a waveform.
The shape of the table thus changes the timbre and
amplitude of the Playback Zone.  Some things to remember
about using CTabs as wavetables:

•  The full table size is always used, even if you can’t see
it.  If you try using a table with a domain smaller than 512,
the Wavetable Zone will read the entire table anyway.

•  The flatter your table is, the less amplitude you will get.
The difference between the minimum and maximum
values of your table will have more of an effect on volume
than timbre.  If you make 2 sawtooth waveforms, both with
a minimum value of zero, and one with a maximum of 127
and the other with a maximum of 64, you will notice a
relatively small difference in timbre, but a significant one
in volume.

Once you have chosen one of the Playback modes described
above, which determines the basic nature of how the sample
will be treated as it is played, you use the menus available
from the other Function Mode buttons to determine details of
Zone behavior and MIDI response.

Advance Mode

Sets the start point for each activation of the sample.

  Restart Mode (default).  Every time the Zone is
activated in this mode, it begins playing at the
absolute start point of the Zone’s sample
region.  If the sample region is changed via
MIDI while a Zone in this mode is active, it will
automatically retrigger from the beginning of
the sample.

  Step Mode.  In this mode, the sample will begin
playing back at the place it left off the last time

Since Release is triggered
by the deactivation of the

Zone, you will only hear the
complete return of the Zone

to 100% source if the
release on the amplitude

envelope is at least as long
as the release on the

envelope chosen in the Env
menu.  Conversely, if you

want it to end with all or part
of the destination wave still

audible, make sure the
amplitude release time is

shorter.
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it was activated.  If its region is moved via
MIDI, it will not retrigger.

Activate Mode

determines the repeat pattern of the Zone (beginning at the
start point determined by the Advance Mode option):

Looping (default).  As long as the Zone is active, it will
continue playing over and over through its region.

Once.  In this mode, the sample will play as long as the
Zone is active, up to the end of the region.

Trigger.  A Zone in Trigger mode will play the entire
region, regardless of how long it is activated.
Note that this is pointless to use in conjunction
with Step mode, as you will always find your
‘step’ ending at the end of the sample region.

Voice Allocation

Determines the priority of the voices assigned to the Zone.
For more details see Appendix 2: Voice Allocation on p. 107.

Free Allocation (default).  When LiSa runs out of
voices, i.e., when there are more MIDI
commands for activating Zones than the
computer’s processor can handle, Low priority
Zones will drop their longest-playing voice in
order to free up a voice for the new note on.
LiSa looks for the longest-playing voice in all
active low-priority zones to turn off.

Never Replace.  High priority Zones never give up their
voices for anything, including other high-priority
Zones and Record Zones.  Beware of
overusing this setting, especially in conjunction
with any kind of sustain.  Once a high Priority
Zone has received a note on, it will never give
it up, even if that means that no new notes can
be produced or recorded.

8/16/32 Voice Max.  These three settings limit the
number of voices for that Zone.  New Note On
messages will drop the oldest voice for that
Zone.

Zone Parameter Control

Enables or disables the connection between the Zone and
the MIDI parameter controls as set in the Assignment
window.  This is useful when editing Zones, to avoid sending
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unnecessary MIDI to a Zone, and when selecting
Zones that you do not want to be effected by MIDI in
performance.

Enabled (default).  MIDI input can effect Zone
parameters.

Disabled.  MIDI cannot effect Zone parameters.
The Zone can still be activated through the
keyboard, and velocity will still effect volume,
but no controllers or modulators will effect the
Zone.

Modulator Running Mode

Determines the start point for LiSa’s internal
modulation functions (see Parameter Control  p. 86
for more on modulators).  In Restart mode, the
waveshape or table that determines the shape of the
modulation will start from the beginning each time the
sample is triggered.  In Free Run mode, the start
location in the table is unpredictable.

Amplitude Envelopes
All Playback Zones have an amplitude envelope -- a
controller for the amplifier that determines how quickly each
sound reaches its maximum volume, and how long it takes to
die out after you stop playing the note.  When a Playback
Zone is created, it comes with one ready-made envelope,
called ‘On Off,’ which immediately turns the sample to full
volume when you activate the Zone, and immediately turns it
off when you deactivate it.

When Listening to
samples from the

Sample Library, LiSa
uses envelope Nr. 1 by
default for amplitude, so
it is wise to not put long

attacks or decays on this
envelope if you want to
audition your sample

properly.
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Filters

All playback zones have an optional MIDI-controllable band-
pass filter, which can be viewed by clicking the red menu
triangle in the lower-left corner of the Zone Editor.

When a new playback Zone is created, the filter is off by
default.  To activate it, click on the On radio button.  Filters
have two parameters:

Center Freq.   This parameter controls the center
frequency of the filter.  Scaled 0-100.

 Bandwidth .  Controls steepness of the filter cutoff.
Scaled 0-99, higher values increase
steepness, decreasing the bandwidth, and thus
the resonant qualities of the filter.

These parameters can be controlled both by MIDI
(parameters available, like all others, in the
Assignment window) and by envelopes, which can be
selected from any envelopes in the Envelope Library.
The depth of the effect of the envelopes can be
adjusted from the numericals labeled Dep.  Note that
unlike the amplitude envelopes for playback Zones,
these envelopes may not be switched via MIDI.  The
effect of the envelopes and the other parameter
controls are additive.

When using filters, keep in
mind two things:

1: They are computationally
expensive, and the more
filtered zones you have

activated, the fewer overall
voices you will be able to

sound simultaneously.
  2:  To get the best results
from your filter, always use

Best Playback quality in
Presets with filtered Zones.
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PPPPaaaatttttttteeeerrrrnnnn    MMMMooooddddeeee
The Pattern modes are one of LiSa’s most powerful playback
options.  A Zone in Pattern mode uses custom templates of
playback pointer movement through the Sample Buffer, which
can be controlled via MIDI.

Except for their sound quality the two types of Pattern modes
function identically.  Patterns function in Zones in a way
analogous to envelopes: you design a set of patterns in the
Pattern editor, store them in a Pattern Library, and call them
up via the special parameter numerical or MIDI.

A pattern is comprised of one to ten elements, each
comprised of a set of instructions to the play pointer, the thing
in the computer that points to the exact location in the Sample
Buffer one is hearing at any given moment.  When a Pattern
Zone is active, it will execute the elements one by one, in an
order determined by the Jump to:  parameter.
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The Pattern Editor
To create a new pattern, select Pattern Library from the
Windows menu, (or type Cmd-3) and click on New.  The
Pattern Editor window can be opened by selecting the Pattern
Window item in the Windows menu or by double-clicking on a
Pattern in the Pattern Library.  Creating a new Pattern will
also automatically open the Editor.  In this window you can
specify the precise movements of the play pointer through the
Pattern’s Region.  Before discussing the Pattern mode
parameters in detail, a few general points:

•  When in ‘show length in samples’ mode, the Pattern editor
counts in absolute number of samples.  Remember that
when you have selected Show Size in Samples, you
normally see time represented in the Coarse aspect of a
numerical in kilobytes (kB), or groups of 1024 samples in
the Zone Editor.  The pattern editor, on the other hand,
shows you the absolute number of samples -- there is no
coarse setting.  400 means 400 samples (circa .009 of a
second) not 400 kB of samples (9.287 seconds).  Thus
when viewing your Zone Editor in Show Size in Samples,
it will not directly relate to what you see in the pattern
editor.

•  Any movement of the play pointer you specify will always
be limited to the size of the Zone’s sample region.  This
will become clearer as you read on, but for now
understand that any movement you specify that would
push the play pointer out of the Zone’s region will be
wrapped around to the beginning of the sample region.  A
pattern will never go outside of its Sample Region,
however you describe its movements.

•  A pattern retriggers when moved based on its Advance
mode.  Like playback regions, when a Pattern Zone’s
sample region is moved via MIDI, it will start again from
the beginning of the pattern if it is in Restart mode.  In
Step mode, it will simply continue the pattern from
whatever point it left off at the last time it was activated.

Pattern Parameters
It is possible to change parameters in the Pattern Editor while
listening to your sample.  You cannot, however, make a
pattern shorter while a voice is activated.

Offset .  This parameter determines how many
samples the pointer skips over at the beginning
of each pass of the element.  Every time the
element plays, it takes the offset and adds it to

The offset starts from the
beginning of the Zone if it is

in Restart mode.  In Step
mode, it will naturally

continue from where it left off
last.
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the current pointer location before starting to
play.

Offset  values can also be negative.  When Offset  is
negative, that means that the play pointer goes
backwards in the sample every pass -- the Offset
value is subtracted from the last location of the
pointer, effectively moving the pointer to the left in the
Sample Buffer window.  In this case, the pattern will
be wrapped to the end of the Zone, by the way – if the
first Element of a Pattern has a negative offset, the
first thing you hear is the end of the sample.

Offset’s  range (in either direction) can be as large as
the entire Sample Buffer, although as mentioned
above, it will always wrap around within the size of the
Sample Region.  Default is 0.

A good rule of thumb to keep in mind when designing patterns is the thousand-sample rule.  As
long as your Offset  and Samples  parameters are under 1000 or so, (about .02 seconds) the

transformations you put into your pattern will be perceived basically as pitch and timbral
changes.  Above this threshold you start to hear more rhythmic chunks of sound.  The exact

behavior will depend on the sample and the relationship between these two parameters.

Length .  This determines the actual number of
samples that the pointer plays when executing
the element.  Whatever your other processes
within the element are, this is what you will
actually hear.  Default is 0.1 seconds.

Repeats .  This determines the number of times the
area defined by Length  will be repeated in
each pass.  Minimum is 0 (default), meaning it
plays through only once, maximum is 9999.

  Pitch Shift .  This numerical alters the frequency of
the samples being played, above and beyond
any other pitch alterations that may be taking
place.  It is a frequency-based parameter, not
pitch, and is thus logarithmic rather than linear.
When this parameter is set to zero, it is heard
at the pitch as established by the keyboard and
the Tun  numerical.  When set to it’s maximum
value (100) it is played back at just under twice
the frequency of its original pitch, which is to
say (just shy of) one octave higher.  On the
other hand, when you go below zero, the pitch
drops much faster.  At -50, you are playing it
back at half the frequency, or one octave
lower, and at -75, an octave below that.  At it’s
lowest setting, -99, you’re playing very low,
about 6 octaves below your original pitch.
Default is 0.
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  Amplitude .  This sets the amplitude of the element,
relative to the overall amplitude of the Zone as
set in Lev .  Maximum is 100 (unity with Lev);
minimum is 0 (no sound).  Default is 100.

Panning .  Controls location of the sound in the stereo
field.  –100 is hard left, 100 hard right.  0
(center) is the default.

Play Direction .  Clicking on this numerical toggles
between a forward (-->) and backward (<--)
direction of play.  Play direction has no effect
on the Offset parameter.  Default is forward.

Jump To: .  The Jump To: box functions as a gateway
from one element to the next.  Clicking on it
reveals a popup menu with the following
options:

•  New Element.  Adds a new element to the bottom of the list.

•  Delete Element.  Deletes current element from the list.  You
cannot delete element number 1.

•  Element <number>.  Selecting one of these assigns the next
element the pattern will jump to.  Any active element may
be chosen, including itself.

Controlling Patterns with
MIDI
Linking controllers to

patterns

To assign a pattern element to MIDI, select any of the four
Pattern Control options in the Parameter menu in the MIDI
pane of the Assignment window, and connect it to a
controller.  This procedure is explained in full in Assigning
Controllers to Parameters on p. 88.

Due to the nature of
pattern Zones, all

parameter control is
treated as Channel
Controllers.  For an
explanation of the

distinction between voice
and channel controls, see
Channel and Voice MIDI

Control, p. 80.
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Linking Controllers to

Pattern Elements

The exact function of MIDI control patterns is set at the
bottom of the Parameter Editor, in the MIDI Controllable
Parameters pane.  Each of the red numbers at the side
indicates one of the Pattern Parameter Controls available in
the parameter menu.  Thus, if you link Pattern Parameter
Control 2 to Aftertouch, you would set exactly what effect
aftertouch has in the top-right set of numericals.  There are
four columns for settings:

Parm.   Clicking on this numerical will reveal a popup
menu with the seven pattern parameters on it.
Select the one you want to use.

Elem.   This numerical selects which of the pattern
elements will be effected.  You cannot change
one parameter for all elements in a pattern,
only one element per controller.

MIn and Max.  For most parameters, the MIn and
Max have the same meaning they would in the
numericals for setting the given parameter.
The MIDI control range of 0-127 is interpolated
between the Min and Max values.  (The
exception to this is the Play Direction
parameter, which can only be set to 0 or 1.
Zero (which is the result of any MIDI control
value less than 64) makes the element play
backwards, and one (for any MIDI value 64 or
over) plays forwards.  Min  may be a larger
value than Max.

Smooth Versus Rough
Patterns
There are two different types of Pattern Mode: Smooth and
Rough.  All of the functions described above work identically
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in both.  The difference is that the Smooth Pattern mode has
special algorithms built in to eliminate clicks and pops often
heard while jumping around in a sample, and the Rough does
not.  Depending on the particular Pattern and sample you are
using, one may sound better than another, or they could
sound more or less the same.  Rough mode often gives an
extra kick to the upper harmonics that gives the sample a bit
more presence.  Another difference between the two is that
the Rough mode is one of the fastest playback algorithms in
LiSa, whereas Smooth, because of the time it spends doing
corrections, is one of the slowest, and puts more stress on
your voice allocation.  So if you have a slower machine, and
you’re concerned about your number of available voices, use
Rough mode when you can.

Pattern Modes are one of LiSa’s most unique abilities, and
the kinds of results you can achieve are almost infinite.
These modes in particular will profit from a great deal of
experimenting and playing with – endless surprising results
are possible.
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RRRReeeeccccoooorrrrddddiiiinnnngggg    aaaa    SSSSaaaammmmpppplllleeee
Although there is a great deal one can do with LiSa only
playing back sampled sounds from disk, it was primarily
designed for live situations in which one can sample another
instrument live, process the sample, and play it back.  This
chapter covers techniques for recording samples into the
Sample Buffer in real time, which are done with Record
Zones.  Many of the modes used in the Record function are
identical to those in Playback.  There are some small
variations, however, and at the risk of being repetitive, they
will all be described in full.

A Few Things About
Recording Samples in LiSa
Clipping and Overdrive

Digital clipping is particularly ugly, and there are possibilities
within LiSa to create certain distortion and overdrive effects,
as we shall see.  We advise that you record your samples as
cleanly as you can, and create any distortion you want within
LiSa, using the Fuz playback parameter described in the
previous chapter.

Mono and Stereo

LiSa accepts mono signals for sampling.  You can use either
input on your Macintosh for LiSa, or both, but if you send
signals to both channels it will be converted to mono.

LiSa can now record independently from its left and right
inputs.  Although the Sample Buffer remains mono, it is now
possible to record samples in stereo, or from 2 independent
sources.  To see how to select the left or right input, see The
Record Treatment Pane on p. 75.  For recording and
playback of stereo samples, see Appendix 3:  Stereo
Recording, on p. 109.

Recording from CD

It is possible also to record from your computer’s built-in CD-
ROM player.  By selecting CD as the audio input in the Sound
(or Monitors and Sound) control panel, LiSa will record
directly from the CD player.

New in Version 2.0:
Independent left and

right channel recording
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Creating a Record Zone
We assume that at this point you are clear on the basic
procedures for creating a Zone and assigning its keyboard
range.  If you aren’t, see Creating a Zone on p. 20.

Defining the Zone’s
Function
The Zone you have just created should be visible in the Zone
Editor window.  The default function for new Zones is
Playback, so the first step is to make it a Record Zone.  Go to
the Zone Function button (the leftmost icon in the top pane) in
the Zone Editor, click on it and select Record Zone from the
pop-up menu.  The Zone Editor looks slightly different from a
Playback Zone, but most of the settings are similar.

Defining the sample region
The Region Pane

The numericals in this section of the Zone Editor define the
sample region of the Zone, and set an activation threshold for
recording.  The first three function exactly as they do in
Playback Zones.

Stt  (absolute start time).  Sets the absolute start time
of the Zone’s region.

Len  (length).  Sets the length of the Zone’s sample
region.

There is no particular
reason to assign a Record
Zone to more than one key

-- The key number you
record from will have no
effect on playback pitch.

Record Zones will self-limit.
That is to say that they will
not go past the end of the
Sample Buffer -- recording
into some random spot in
your computer’s memory

would crash your machine.
(This does not apply to all

Zone functions).
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Mvr  (movement range).  Sets the area within the
Sample Buffer that the Zone can move in when
controlled by MIDI.

TOn/TOf  (threshold on/off) This is a dual numerical.
TOn is normally visible – to view and edit TOf,
press the Shift key.  These parameters (range
0-127) set the relative input level at which the
recording process will be initiated and ended.
At 0, it will record all input, at 64 it will record
only signals that are more than half of the
maximum input, and at 127 it will record hardly
anything.  If it is set to any non-zero value, the
Record Zone will only record if it is both
activated from MIDI and is receiving a signal
above the threshold.  When the input drops
below the level set in TOf, it will pause the
recording process.

There are two things to keep in mind about using a threshold.  Firstly, attack and decay times are
very short.  One sample with an amplitude above TOn will initiate recording, and 20 milliseconds
or so of sound below the level of TOf will deactivate it, depending on your machine.  Secondly,

the threshold value takes priority over all mode settings.  As long as the signal is below TOn, the
record pointer does not move.  This applies to all modes, including Trigger mode.  In order to

record a whole Zone in Trigger mode, it is necessary to set TOf to 0.  In a Zone in Loop mode,
for example, you might hear the sample playing, but you will not record exactly onto what you

hear -- you will record beginning at where it last stopped.  You can check the activity of the
record pointer in the Status window by selecting the Show Current Sample Pointer option in the

Options menu.  The current location of the sample pointer will be displayed in the System
Messages pane of the Status Window.

Defining Record Modes
The Record Mode Icons

Clicking on each of the 5 mode buttons will reveal pop-up
menus showing the possible record options:
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The Recording Mode pop-up Menu

This covers what happens to the old sound (if any) in the
sample region at the moment of recording.

  Replace.   (default).  When the Zone is in this
mode, whatever sound was in the Sample
Buffer prior to the recording will be overwritten.

  Overdub.   In this mode, the newly recorded sound
is added to whatever sounds were present in
that location in the buffer.  The original sound
will remain.  Please note that this is purely
additive and there is no limiting, so repeated
overdubs will eventually lead to distortion.  This
is not necessarily a bad thing, but something to
be kept in mind.  The amount of the original
material you will hear depends on the
Feedback setting in the Record Treatment
pane.

The Advance Mode pop-up Menu

Sets the record start point for each activation of the Zone.
These work on the same principle as the Advance Mode
items in Playback Zones.

  Restart Mode (default).  Every time the Record Zone
is activated in this mode, it begins recording at
the absolute start point of the Zone.

  Step Mode.  In this mode, the sample will begin
recording at the place it left off the last time it
was activated.  For example, if a Record Zone
has a sample region 5 seconds long, and you
record in 3 seconds of sound, the next time
you activate the Zone, it will begin at 3
seconds plus 1 sample, leaving your first 3
seconds of samples untouched.  Depending on
the Activate Mode (see The Record Treatment
Pane, p. 75), it will either continue cycling
through its portion of the buffer, or step through
until the end of the sample region.

The Activate Mode pop-up Menu

Determines how the record pointer will move through the
Sample Buffer when it is activated (beginning at the start
point determined by the Advance mode option).

  Looping (default).  As long as the Zone is active, it
will continue recording over and over through
its allotted area in the Sample Buffer.
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Regardless of the Recording Mode, a Zone in
loop mode will overdub material from that
particular activation, in an amount determined
by the Fdb  parameter (see above).

  Once.  In this mode, the sample will record as long as
the Zone is active, up to the maximum length
of the Zone.

  Trigger.  A Zone in Trigger mode will record the entire
sample region, regardless of how long it is
activated.  Thus, a short keystroke can initiate
the recording of a very long sample.

The Auto Save Session pop-up Menu

Handles direct saving of samples to disk.  This is discussed in
more detail in Load Session Zones, p. 82.

Disabled (default).  The Zone will not auto-save.

Enabled.  For samples to be auto-saved, this must be
enabled and the Auto Save Recording Sessions
item in the Options menu must be enabled
(checked).  If only one or the other is on, no
auto-saving will occur.  (This is in order to
make it easy to disable all auto-recording
zones when editing your Setup.)  When both of
these are enabled, it means that every time a
new recording is made into the Zone, it will be
saved immediately to disk.  Make sure you
know when you are using this, or you can fill
up your disk awfully fast!  Recorded samples
are immediately available for reloading into
LiSa using Load Session Zones.  (p. 82.)
When you quit LiSa, it will create a folder in the
same folder that contains your Setup file.  This
folder will be named with the format ‘<date>
Sessions <time>’.  Saved soundfiles are in
Sound Designer II mono format, 44.1 kHz.  For
more on this, see Managing Sessions on p. 83.

The Zone Parameter Control pop-up

Menu

Enables or disables the connection between the Zone
and the parameter controls as set in the Assignment
window.

  Enabled (default).  MIDI input can effect Zone parameters.

Recording while editing:  If
you activate a Record

Sample Zone by option-
clicking on the virtual

keyboard, instead of via
MIDI, it will not save the
recording as a session.
Once the recording is

finished,  LiSa will prompt
you to name and save the
soundfile as one would any

other file.
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  Disabled.  MIDI cannot effect Zone parameters.
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TTTThhhheeee    RRRReeeeccccoooorrrrdddd
TTTTrrrreeeeaaaattttmmmmeeeennnntttt    PPPPaaaannnneeee

The variables in this pane control input, output
and feedback levels for the sample as it is
being recorded.  All of these are also
controllable via MIDI from the Assignment
window.

Out/Pan (output level/panning) This is a dual
numerical.  Out controls the overall level of the
Zone.  Range is 0-100, with 0 meaning no
output, and 100 meaning full sample volume
level.  This value does not effect the sample
itself, only it’s output level.  Default is 100%.
Pressing the Shift key will change it to the Pan
parameter.  Range is -100 to 100, from 100%
left to 100% right.

Inp     (input level/channel).  This dual numerical sets
both the attenuation of the signal input as it is
recorded, and the channel which the Zone will
record from.  Note that this value does not
effect the level of the incoming signal to the
Macintosh’s analog-digital converters -- it
cannot be used to control clipping, you need to
do that at your sound source.  This parameter,
being MIDI-controllable, is best used when
attenuating input in live situations.  Default is
100%.  Holding down the Shift key will turn this
numerical into a channel select, with the
options of Left, Right, or Both.

Fdb     (feedback).  If the Zone is in Loop mode, this
parameter will effect how much of the previous
sample you hear.  If this value is anything
higher than 0, some amount of the previous
signal will be mixed in with the new signal as
the buffer is re-recorded, with the amount
depending on this setting.  Range is 0-100% of
the original signal.  Default is 100%

Ovd    (overdrive).  Overdrive is an extension of the
feedback control -- rather than attenuating the
previous signal, it amplifies it.  After repeated
looping, you can get some rather interesting
distortion effects with Overdrive.  You can think

When you record a
sample in Looping and
Overdub mode, you will

hear the old material
every time through before
it is recorded over.  If you
do not  want to hear it, set

Out  to 0.



76

of it as Feedback values of more than 100%.
In order for Ovd  to take effect, Fdb  must be
set to 100.  Default is 0.

Recording
Once you have defined your Zone, you’re ready to record
something into it.  Information about the recording process
may be found in the Status window.

The Input Level  monitor shows the input level to
LiSa through your computer’s analog-digital
converters.  This should not go into the red --
that means annoying digital clipping is
occurring, and you will have to readjust your
levels either from your mixer or in the System
Settings dialog box (p. 17).  The Input level
display monitors in stereo.  The top half of the
bar monitors the left channel, the bottom half
the right.

The Rec monitor turns magenta if a Record Zone is
currently active.  Remember that this does not
necessarily indicate if recording is actually
taking place.  When TOn is above 0, it will only
record when the level of your input exceeds
the threshold values.  Selecting the Show
Current Sample Pointer option will allow you to
see if recording is actually taking place.

The Sample Buffer pane will show a graphic representation of
the samples currently in RAM.  When you record, you should
see your sample appear in the buffer after recording is
completed, or if you are in Looping mode, after each loop.
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The Voices  monitor indicates how many voices are
currently active.  The number below the red
button indicates the number of voices
recording, below the green button, the number
of voices playing back.

Activating your Record
Zone
To initiate recording, simply press the key on your keyboard
that is assigned to your recording Zone’s keyrange.
Assuming you are not using a threshold, recording will
commence immediately, in whatever fashion you have set in
the Zone Editor.  Once you have recorded, you can play the
sounds using Playback Zones.

You will never hear your
recorded sound directly as
you record it, unless you
have the Sound Thru

option selected to a non-
zero number in the System

Settings Dialog.  In Overdub
mode you will hear the

original sample, and if you
are looping and

overdubbing, you will hear
the last recorded version.
In Once or Trigger mode,
you will hear nothing as
you record.  Note that if
you do havea non-zero
Sound Thru setting, you

will hear all input into LiSa,
if it is being recorded or

not.
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FFFFiiiilllleeee    mmmmaaaannnnaaaaggggeeeemmmmeeeennnntttt
ZZZZoooonnnneeeessss
There are three special kinds of Zones devoted to dealing
with soundfiles: Static and Dynamic Load Sample Zones, and
Load Session Zones.  A Load Sample Zone is designed for
loading samples that have been previously recorded.  Load
Session Zones are for loading samples which have been
recorded live.

Load Sample Zones
There are two varieties of Load Sample zones, Static and
Dynamic.  They both serve the same basic function of loading
soundfiles from disk into the Sample Buffer, but with different
modes of operation.  Like all Zones, Load Sample Zones are
spawned by creating a new Zone in the Zone Library and
selecting Static Sample Load from the Function Icon menu in
the Zone Editor.  Once you’ve done this, you’ll notice that it
looks rather different from the Zone Editor windows we’ve
seen so far.

Static Zones

Firstly, you will notice that no Mode Icons remain, and there
are no CTabs next to the Stt  and Len  numericals.  This is
because that except for keyboard activation, Static Load
Sample Zones are not MIDI-controllable.  The Load Sample
File pane on the bottom right is where you select the sample
to be loaded.
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Selecting a Sample to Load

To select a sample to load, drag the name of the desired
soundfile from the Sample Library window into the Name box
in the Load Sample File pane.  The name of the selected file
will appear in the Name box in the Zone Editor Window.

Loading a Sample

When you activate a Load Sample Zone, it will load the
soundfile from disk into the sample region specified by the
Stt  and Len  numericals in the Region pane.  Some things to
keep in mind about loading samples from a Static Zone:

•  Sample Loads are Destructive.  That is, whatever
material is in the Sample Buffer already in the region of
the load Zone will be overwritten.  It is not possible to mix
a statically loaded sample with sound previously existing
in the buffer.

•  Region Size.  The amount of time you assign to your
sample region in the buffer need not be the same size as
the sample.  If the region is larger than the sample to be
loaded, it will load the entire sample, and leave any other
material inside that region untouched.  If the region is
smaller, it will load as much as will fit in the region,
starting from the beginning of the soundfile.

When you attempt to load a sample you will get a
notification (in the System Messages pane in your Status
window) indicating if the sample was successfully loaded.
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Dynamic Zones

Dynamic Load Sample Zones work on a similar principle, but
have more options available.

Movement

Dynamic Load Zones can be moved via MIDI, like a Playback
or Record Zone, with a corresponding CTab.  The Mvr
parameter will set the movement range.  Length may not be
altered, or even set – the size of the Zone automatically
adjusts to that of the sample being loaded.

Multiple samples

Like a Static Load Sample Zone, samples are added by
dragging them from the Sample Library.  Up to eight samples
may be dragged into the Zone.  Moving them up and down in
the window will change their load order.  To see why you
might want to do this, see below.  Each Mode has one or
more available options, which may be selected in the Options
pane.

Loading modes

IIIImmmmmmmmeeeeddddiiiiaaaatttteeee    LLLLooooaaaadddd....

When the immediate load radio button is selected, all
samples in the Sample List pane are loaded in top-to-bottom
order.  An activation of any length will load the entire sample
collection.  (Like the Static Zones, you can think of this as
being in Trigger mode.)  When in this mode, there is one
option:

New in Version 2.0:
Load multiple Samples

from a single Zone.
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Merge .  When this is selected, the samples to be
loaded will be mixed with the samples already
present at that location in the buffer, like a
record Zone in Overdub mode.  The Level
numerical controls the amount of the new
sample to be added to the old.  Continued
adding of samples on top of each other will
create the same kind of distortion made by the
Fuz playback parameter, not digital clipping.

DDDDyyyynnnnaaaammmmiiiicccc    LLLLooooaaaadddd....

In Dynamic Load mode, the sample is loaded only as long as
the Zone is active.  If you have two 10-second samples, and
hold the key controlling the Zone down for 5 seconds, only
the first 5 seconds of the first sample in the collection will be
loaded.  The options for this Mode are rather complicated,
and build on one another:

Listen .  In Dynamic mode, you will probably always
want to have this button checked.  This plays
the sample as it being loaded into the buffer.

Offset .  When Offset  is selected, the velocity of the
note on event that activated the Zone is used
as an index to select which sample is to be
loaded first.  The full range of the velocity is
divided among the number of samples in the
collection.  In the example above, a gentle
press on the keyboard will load the collection
starting with the sample ‘I’m on fire’, a light
medium one ‘love will last’, a more determined
one “harp riff’ and a hard strike ‘kabuki1.c’.
The samples will always be loaded from the
beginning of the soundfile, and will stop
loading when the Zone receives a note off.
Once one sample is finished, it will start
loading the next.

Only One . Only available when Offset  is selected.
When Only One is selected, the Zone will only
load one of the samples in the collection.  In
the above case, with Only One selected, a low-
velocity note on would load ‘I’m in love' alone,
no matter how long the key was held down.

Due to the  nature of mouse
clicks and keypresses, and

the way the Macintosh
prioritizes tasks, Dynamic

Load Sample Zones will not
properly load samples when
activated from the computer.

An external MIDI source
must be used.
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Load Session Zones

There is another way to record and play back live samples,
using Sessions.  When using a Record Zone and then playing
it back you are only dumping sound into the buffer.  Using
Load Session Zones, you can save any number of samples
when recording live, and then load them at a later time during
your performance.  To use Sessions in a live performance:

•  Enable Auto Save Recording for one or more recording
zones.  This will automatically save whatever your Record
Zone records to disk.

•  Once you have recorded some live sounds, you reload the
saved recordings into the Sample Buffer with a Load
Session Zone.

•  Play the sessions back with a Playback Zone.

Recording Sessions

Record Zones have the option of being set to save recorded
samples to disk or not, via the Auto Save Recording function.
(For a full explanation on how to auto save Recordings, see
The Auto Save Session pop-up Menu on p. 73.)  You can
record as many sessions as your hard disk can hold.  They
will be saved into the same folder as your Setup, and
automatically named ‘Session 1,’ ‘Session 2,’ etc.  Sessions
start numbering themselves anew every time you start up
LiSa.

Loading Sessions

A load Session Zone, unlike a Load Sample Zone, is best
used over a large keyrange.  When you activate a key in this
Zone’s range, it will load a Session file based on the relative
number of that key in the Zone’s keyrange.  The first key in
the range will load session 1, the second will load session 2,
and so on, depending on the number of sessions you have.  If

Every time you activate
a Record Zone that has
Auto Save Recording
enabled, you create a

new Session.
Regardless of which

Record Zone you
activate on which MIDI

channel, it is simply
saved as the next

consecutively numbered
Session.
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you attempt to load a session that does not yet exist, you will
get an error message in the System Message pane.

There is a numerical in the Load Recorded Session pane
called Start ID .  (The box next to the label Name in this
pane is display-only -- it is connected to the Start ID
numerical.)  This allows you to choose the session numbers
that your keyrange will load into the Sample Buffer.

For example, you might want to have multiple Load Session
zones on different MIDI channels.  If your Zone on channel 1
has 10 keys assigned to it, they will default to playing back
Sessions 1-10.  You can create a second Load Session Zone
on channel 2 as well, and have it play Sessions starting with
number 11 by changing the Start ID numerical to 11.  The
number shown in Start ID  will always be the Session
number played by the ‘lowest’ key in the keyrange.

The effective number of sessions that can be loaded is 1144.
The highest possible Start ID number is 1024, and if you have
a Load Session Zone covering all 120 MIDI notes, 1144 is
your maximum.  Also note that the Sample Regions of these
Zones cannot be moved or resized via MIDI.

Session loads work just like Static Load Sample loads in
other respects.  Loading a Session will only fill the Sample
Buffer up to the size of it’s Sample Region, regardless of the
size of the Session file it is loading, always starting from the
beginning.  You will not hear a Session when it loads -- you
need a Playback Zone in order to be able to hear the
Session.

Managing Sessions
Saved Session folders

If you have recorded Sessions, they will be automatically
reorganized every time you shut down LiSa.  When you quit,
it will create a folder in the folder that contains your Setup file.
This folder will be named with the format ‘<date> Sessions
<time>’.  They are saved with the names ‘Session 1’,
‘Session 2’, etc.  These can then be renamed as samples for
later use, or reloaded as Sessions in another performance.

When loading Sessions, LiSa looks in the folder containing
your Setup, and loads whatever it finds there with the name
‘Session’ followed by a number.  This means that any
samples can be loaded as Sessions by naming them
‘Session <number>’ and putting them in this folder.  They
could be previously recorded sessions or any old samples
that you’ve named in this format.  (This has no particular
advantage over simply making a bunch of Load Sample

The note values of the
keyrange you assign to
your Load Session Zone

will not effect their
playback pitch!  This

Zone only loads, it does
not play.

If you are planning to save
sessions, it is very

important to save your
Setup BEFORE recording
any sessions.  Sessions
recorded by an unsaved
Setup will appear in  the

folder containing the LiSa
application, not in a

sessions folder.  One will
be created if you save

your Setup before quitting,
but it will be empty.

Should you find your
Sessions folder empty,

check in the folder
containing the application.
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Zones with old session samples, but you can do it.)  If you
choose to use those Sessions again, as Sessions, you have
to take them out of the folder they were saved into.  LiSa will
not look in folders inside the folder containing your Setup.
During a performance, Sessions must be directly in the folder
containing your setup.  After quitting, LiSa automatically
moves them as described above.

Warning:  If you have moved old sessions back into your
Setup’s folder and record any new sessions, LiSa will write
over the old ones.  If you have old Sessions numbered 1-20
in that folder, and record a new Session, LiSa will not record
it as session 21, but will rather write a new file entitled
‘Session 1’, deleting your old ‘Session 1’ in the process.

Copying Buffers

Another one of LiSa’s live performance abilities is the
capacity to resample something that has already been played
and return it to the Sample Buffer.  This is done with Copy
Buffer Zones.  (For basic information about LiSa’s buffers and
how to resize them, see Size of Buffers on p. 15).  Copy
Buffer Zones can be set to copy either the Output Buffer or
the Process Buffer.  You toggle between these two choices
by clicking on the Buffer  numerical on the right-hand side of
the Zone Editor.  The Region  pane contains numericals for
determining the size and location of the Zone’s region.  As in
Static Load Zones, the sample region cannot be changed via
MIDI.  The numericals in the Copy Buffer to Sample
Buffer  Pane set the region of the Process or Output Buffer
that is copied to the Sample Buffer.

The Output Buffer

The Output Buffer is normally empty.  To copy it to the
Sample Buffer, it must first be filled.  Recording is initiated by
a MIDI control message.  It accepts any value from a

These Zones only copy
from one buffer to another.
In order to save any of this

information to disk, you
have to save it from the

Sample Buffer with a Save
Sample Zone.
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controller to trigger recording -- the controller number you set
yourself, in the System Settings... dialog from the Global menu
(p. 16).

The Output Buffer Rec Start  numerical is where you set
the controller number.  Any number, including zero, which
you send from this controller to Lisa on the channel you have
designated as the System channel (see MIDI Settings p. 16),
will enable recording.  Recording will not commence until
some sound is produced.  Once that happens, the indicator
above the rightmost of the two Voices  monitors in the Status
window will turn from green to red.

This indicates that the Output Buffer is being filled.  It will turn
back to green once the buffer is full.  There is no way to stop
the recording process once it begins -- it is always in Trigger
mode.  Once the buffer is recorded, it can be copied into the
Sample Buffer any time by activating a Copy Output Buffer
Zone.  This process can be repeated at any time -- the old
buffer will be overwritten by the new sounds.

The Output Buffer records everything that happens while it is
being recorded -- including nothing, so if there are silences in
your performance, there will also be silences in your Output
Buffer, and thus also in your Sample Buffer when you copy
the Output Buffer to it.

The Process Buffer

Unlike the Output Buffer, the Process Buffer continually
records LiSa’s output.  It is a circular buffer, meaning that as
new information is added, the oldest information is dropped to
make room for the new.  When LiSa is not producing any
sound, the Process Buffer is inactive -- it does not fill up with
silence.

When you copy the Process Buffer, you are copying some
portion of the last few seconds of sound (depending on the
size of the Process Buffer and sample region) into your
Sample Buffer.  This makes it possible to record something
live (in a record Zone), load it (Load session Zone), play it
back through some process (Playback Zone) load it again
after it was processed by the last Playback Zone (Copy
Process Buffer Zone), and process it again through the same
or another Playback Zone.

Activating this Zone simply takes a part of the Process Buffer
and copies it into the Zone’s sample region, exactly like a
load from disk.  You can also set the Start and Length of the
portion of the Process Buffer you copy, but since this is a
circular buffer, you cannot predict with much accuracy exactly
what sounds you will get.
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PPPPaaaarrrraaaammmmeeeetttteeeerrrr    CCCCoooonnnnttttrrrroooollll

Setup
For the basics of connecting and configuring MIDI in LiSa,
and for setting MIDI preferences, please see MIDI Setup,
page 13.

Parameter Control Types
MIDI

MIDI is LiSa’s primary interface to the outside world, and in a
performance situation all of your manipulations of LiSa will be
done via some sort of MIDI instrument.  LiSa gives you
maximum flexibility in assigning controllers to different
parameters of the program.  There are six primary functions
of MIDI:

•  Activating Zones.  This is done using note on and note off
MIDI commands, much like MIDI on a standard sampler.

•   Moving and resizing the sample region of a Zone in the
Sample Buffer.

•  Changing Zone parameters such as panning or distortion.
•  Controlling input and output levels of samples.
•  Amplifying the current Zone.
•  Initiating an Output Buffer recording.

Modulators

Zone Parameters can also now be controlled using internal
table-driven modulators.  Their operation is explained in full
below.  In all respects regarding Setup and connections to
Parameters, they are treated no differently from MIDI
controllers.

Architecture
Parameter Controls are connected to Zones in the Parameter
Control pane of the Assignment window.  This will always
mean first selecting a Parameter to control, and then
assigning it to a Controller, which can be created in the

New in Version 2.0:
Internal Modulators

New in Version 2.0:
Control and Parameter

Libraries
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Controller editor.  There is a Parameter Library, but you
cannot create new Parameters in it.  The number of
Parameters in LiSa is fixed, and the Library is there primarily
for reference and drag-and-drop convenience.

Controllers, whether they be MIDI or Internal Modulators, are
stored like all other data in a Library, created in an Editor, and
named with a name of your choice.

MIDI in LiSa is assigned to Voice Layers, and MIDI sent to a
Voice Layer can effect all of the Zones whose keyranges are
in that layer.  It is possible to vary the way MIDI effects the
various Zones on a channel, or not have a Zone be effected
by MIDI at all.  A MIDI input, typically a 7-bit value (0-127), is
assigned to a variable.  This could be sample region length, a
degree of effects processing, or almost any of the numbers
appearing in numericals in the Zone Editor.  Before this
number is applied to the variable it can be passed through a
special table called a Control Table, or CTab.  These tables
can be custom-designed to map the normally linear values of
a MIDI controller.  (See Tables, p. 43.)

You can see the MIDI input from your instrument in the MIDI
Monitor pane of the Status window.

The Parameter Control

Pane
The Control Pane in the Assignment window contains 16
pairs of popup menus, in which MIDI inputs or LiSa’s internal
modulators can be assigned to various Parameters.
Assigning MIDI inputs to either effects Parameters or sample
region Parameters involves the same process, all of which is
done in the Assignment window:

Selecting the Voice Layer in the Zone Assignment
pane (see Assigning Controllers to Parameters
below).

Selecting a Parameter to be controlled in the
Parameter Control pane.
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Assigning Controllers from the Controller Library to
sample region or effects Parameters in the
Parameter Control pane.

Creating and assigning CTabs, if desired, to the
various Parameters.  This is done in the Zone
Editor.

Voice Layers and MIDI

Channels

Each of the radio buttons on the top of the
Assignment window is actually a popup menu, which
can be set to any number from 1 to 16.  This number
sets the MIDI channel number the Voice Layer
listens to.  It is possible to have any number of Voice
Layers assigned to a single MIDI Channel.  This has
two main consequences:

•   You can activate more than one Zone from a single key.
This is done by assigning the Zones to the same key in
different Voice Layers responding to the same MIDI
channel.

•  Controllers can effect more than one Voice Layer.  By
assigning a Controller to a MIDI Channel that effects more
than one Voice Layer, one Controller can effect
parameters in multiple Voice Layers.

If nothing is selected in the Assignment Window, selecting
Copy from the Edit menu will copy the entire Voice Layer to
the clipboard, from where you can paste it into another Voice
layer in the same, or another, Preset.

Assigning Controllers to

Parameters

The Parameter Control pane of the Assignment Window can
be thought of as the patchbay where you can connect
Parameters to specific Controllers (either external MIDI or the
internal modulators see below).  The pane is comprised of 16
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pairs of popup menus.  There are two ways to assign a
Parameter to a Controller:

Click on the left-hand menu.  This is the Parameter
Select menu.  A popup menu of all Parameters
will appear.  Select the Parameter you want to
control.  From the right-hand menu, the
Controller Select menu, select a Controller, or
create a new one.

Drag Parameters and Controllers from their respective
Libraries to the appropriate menu spots in the
Parameter Control pane.

A Parameter must always be selected before a Controller.  A
Controller Select menu will not respond to a click unless it
has a Parameter assigned to it.  A Parameter may only be
connected to one Controller per Voice Layer.  Used
Parameters will be greyed out in the Parameter Select menu,
and bulleted in the Parameter Library.

Parameters and
Controllers
Parameter Library

The Parameter Library is fixed – you can use it to drag
Parameters to the Assignment window, and use it as a
reference to see which Parameters have been assigned to
the current Voice Layer.  Assigned Parameters are marked
with a bullet in the Parameter Library window.  A Parameter
may only be assigned once in a given Voice Layer.  Unlike
other Libraries, the bulleted Parameters indicate which are
used in each Voice Layer, not each Setup.

Controller Library

The Control Library will always appear at first with a limited
set of the standard MIDI controls.

You can add your own custom controls, which may be either
MIDI inputs or modulators, to the Controller Library.  You can
drag Controllers into the Assignment Window, or access them
from the popup menus in the Control pane.

Creating Controllers

Controllers may be created from either the Controller Library
or the Parameter Control pane of the Assignment window.
The Control Editor window will automatically open when you
create a new Controller.
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To create a new Controller from the Library: click on
New.

To create a new Controller from the Assignment
Window, select New Controller… from one of
the Controller Select menus in the Parameter
Control pane.

Once you have created a new Controller, the Controller Editor
will automatically appear, and it will able to be edited.

Editing Controllers

At the top of the Controller Editor are numericals for the
number and name of the Controller.  Like Zone numbers,
these are for internal reference only and may not be changed.
Scrolling through it will bring up the Controllers in the
Controller Library for editing.  The second numerical is a
name field, which can be edited the same way as Zone
names.  The two radio buttons select between external MIDI
control and internal modulators.  You can scroll through
available Controllers in the Controller Editor using the left and
right arrow keys.

MIDI Controllers

Clicking on the Type numerical will bring up the MIDI
Controller Menu.  This shows the MIDI input options
available.  The Controller item has a submenu showing all
128 MIDI controller numbers.  Select the menu item, rename
the Controller, and you’re done.  If your MIDI is plugged in, it
is also possible to select your MIDI input by selecting the
Type numerical and activating the controller you want to use.
LiSa will automatically detect which controller you are using
and show it in the numerical.  This works for all MIDI except
note number and velocity.  (Hitting a key will enter Aftertouch
or Poly Key Pressure, depending on which your keyboard is
using)
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Channel and Voice MIDI Control

There are two different types of MIDI input in LiSa: Those that
effect the entire Voice Layer, and those that only effect the
current sounding voice.  Poly Key Pressure, Note Number,
and Note Velocity will effect every voice separately – if
Velocity, for example, is connected to Tun, the pitch of each
voice will depend on the velocity of the key that activated it.
The other Controllers, including Last Note Number, and Last
Velocity, will effect all active Zones in the Voice Layer.  If Last
Velocity is connected to Tun, all active Zones will change
their pitch when a new note is struck.  Likewise with panning
– A Channel Controller will move all voices on that Voice
layer to the new panning position.  (This can be varied from
Zone to Zone with CTabs, of course)  All of LiSa’s internal
modulators are Voice Controllers

Modulators

In addition to external MIDI, you can create any number of
internal modulators to control Parameters.  These work by
automatically reading tables at a preset speed.  LiSa has
some tables built in, but it is also possible for the modulators
to read from custom tables.  The Modulator section of the
Controller Editor has three variables:

Shape .  This popup menu determines the wave shape
of the modulator.  There are four permanent
tables built into LiSa, with sine, sawtooth, and
square waves, and a final, which has a random
distribution.  To use a custom table, select
Table from this menu.

CTab.  If you have selected Table from the Shape
menu, this menu will become available.  You
can select a table from ones you have already
created, or make a new one by selecting New
Table… from the menu, which will open up the
Table Editor.

Speed .  Sets the speed at which the modulator will be
read.  The maximum and minimum speeds will
vary depending on the size of the table.
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CTabs as modulators

When LiSa processes sound, it does so in groups of 256 samples.  This is known as the audio
vector size.  When you set the Modulation Rate to it’s maximum speed (99) what that means is
that the Parameter you are modulating is changed once every 256 samples, or once per audio
vector.  Thus, tables are non-interpolating between their X values.  This has several effects to

keep in mind when designing tables for modulators:

The smaller the table, the faster the modulation rate.  If you want to maximize the modulation
rate, use the smallest table possible.  For example, if you want to modulate pitch with a square
wave, use a table with a domain of two, with the first value set to 0, and the second to 127.  If

you use a table with a domein of 128, with each value repeated 64 times, LiSa will calculate 64
vectors at the first value before switching to the next.  At a modulation speed of 99 this would
mean that the small table would change values 172 times per second, and the large would

change only 2.6 times per second.

High speeds, big tables for smoothness.  If you are trying to get a smooth curve at a relatively
slow rate, use a large table at a high speed.  This minimizes the number of audio vectors

calculated at one value, and minimizes staircasing.

Modulation rate changes geometrically.  Every increment in the Speed numerical of the
Controller Edit window adds one to the number of audio vectors that are calculated before

moving on to the next value.  At a rate of 99, it is one vector.  At 98, it is two, making it twice as
slow, at 97 it is three, and so on.   All pre-built modulator tables contain 16 values.

Controller Behaviors
Some Zone Parameters behave slightly differently under MIDI
control than when they are changed by hand in the Zone Edit
window.  All Controller behaviors are described in detail
below.  Note that ‘Controller’ here means any kind of input
that can be assigned in the Parameter Control pane of the
Assignment window; i.e., velocity, pitchbend, etc. plus internal
modulators.

For Parameters that only refer to specific Zone functions or
modes, Controllers will only effect Zones of the appropriate
type; e.g. changing the Spiralness Parameter will only effect
Playback Zones in Spiral mode.

Also keep in mind that although MIDI control is assigned to
an entire Voice Layer, individual Zone responses will depend
on what (if any) CTab is assigned to the individual Zone’s
MIDI input and the settings in the Region pane of the Zone
Editor window.
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Sample movement parameters

Nothing.  No Parameter is available, and no
Controllers may be assigned in the
corresponding Controller Select menu.

Absolute Region Start.  This Parameter controls the start
position of the sample region of the Zone.  This
Parameter is always additive, e.g., the higher the value,
the further ahead of the original sample region start
point (as set in Stt  in the Zone Editor) the start of the
sample region will move.  The maximum range covered
by this Parameter will depend on the size of the Mvr
(movement range) numerical.  The CTab connected to
the Abs. Start  value is the one to the right of the Mvr
numerical in the Region pane of the Zone editor.

Special Feature: The icon in the center of the Region
Pane in Playback Zones is actually a button which
toggles between two slightly different playback modes.
When this button is selected, the behavior of Absolute
Region Start changes.  Instead of moving the start
point of the Zone, it moves the sample pointer itself
within the sample region.  The Zone’s region does not
change, and the Mvr  Parameter has no effect.  Every
time your Controller moves the pointer, the sample will
start to play again from that point, and will continue to
the end.  Once it reaches the end of the sample, it will
either loop or stop, depending on the Advance mode
of the Zone (p. 59).

Relative Region Start.  If the Mvr  of a sample is very
large, it is possible that the jumps between
Controller values will skip more samples than
you would like.  Rel. Start acts as a fine tuner
for your sample region start point.  The entire
offset range of Rel Start  is always 8% of Mvr .
This means that if you also have Abs. Start
enabled, controller values 1-10 of Abs. Start
cover the same range as values 0-127 of Rel.
Start .  It is not necessary to have Abs. Start
enabled for Rel. Start  to work.  The CTab
connected to the Rel. Start  value is the one
to the right of the Stt  numerical in the Region
pane of the Zone editor.

Region Length.  This Parameter changes your total
sample region length in relation to the original
length set in Len  in the Zone Editor.  A control
value of 0 will shrink the sample region to 1.5%

If you set your Mvr
high enough to move
your sample region

out of the buffer, LiSa
will loop the region
around back to the

beginning of the
buffer.

New in Version 2.0:
Region/Pointer Option Switch
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of its original length, and a control value of 127
will double it.

Zone Reset.  When this is sent a 0, and only a 0, all
Zones on the channel, active or not, will
automatically revert to their original settings as
described in the Zone editor.  This includes
start and length of the sample region and
effects settings.

Output Parameters

Output Level.  Sets output level for playback Zones in
all modes.  Equivalent to the Lev numerical in
the Zone Editor.

Panning.  Controls the pan position of a Zone.  0 =
100% right, 127 = 100% left.  Has no effect on
Autopan Zones.  The exact behavior of this
input depends upon whether the MIDI control
is a voice or channel control.(see Channel and
Voice MIDI Control, p. 91.)  If it is voice-
specific, pan for each instance of a Zone will
vary depending on its MIDI control.  If channel-
specific, all voices in the Voice Layer will move
together.

Tuning.  Works the same way as the Tun  numerical
found in all Playback Zones.  You can set the
range of pitch change in the Pitch Bend Range...
dialog in the Global menu.

Fuzz.  Amplifies previously recorded sample.  Works
exactly the same way as the Fuz numerical in
the Playback Treatment pane of the Zone
Editor.

Envelope Select.  Sending a Controller value to this
Parameter will change the envelopes in all
Zones in the Voice Layer to the envelope of
the corresponding number in the Envelope
Library.  This index works like program change
messages, i.e. the Controller value will always
be one less than the index number of the
envelope.  Control value 0 brings up envelope
1, etc.  To avoid changing all envelopes in a
layer identically, use CTabs or voice-specific
Controllers with this Parameter.

you can get different Envelopes
(or patterns) in different Zones
by giving each Zone a different

CTab for this variable.
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Pattern Controls

Pattern Select.  Sending a Controller value to this
Parameter will change the pattern in all pattern
Zones in the Voice Layer to the pattern of the
corresponding number in the Pattern Library.
If you have 10 patterns, control value 0 or 1 will
load pattern number 1, 2 will load pattern 2,
etc.  Note that this is different from how Tables
and Envelopes are selected.  To avoid
changing all patterns in a layer identically, use
CTabs or voice-specific Controllers with this
Parameter.

Pattern Parameters 1-4.  These are assigned to different
aspects of a Pattern Zone.  The operation of these
Controllers is discussed in full in Pattern Mode , p. 63.

Playback Zone Parameters

These items control depth or degree of output effect on
Playback Zones in various modes.  Full control range covers
the full range of the Parameter, (scaled to seven bits of
resolution) however its range is expressed numerically in the
Zone Editor.

Spiralness.  Changes the mystery Parameter (Spl) for
Zones in Spiral mode.

Playback Direction.  This control only works for
Playback Zones in Back and Forth mode.  Any
control value below 64 will force the playback
pointer to a forward direction, no matter what
direction the Zone was originally playing in.  At
64 or above it will force the playback pointer to
move backwards until it reaches the start of the
region.

Resonance Frequency and Resonance Depth.  Controls
these two values for Zones in Resonator mode
(Res and Dpt ).

Scrub.  Changing this control value ‘scrubs’ the sample
backwards and forwards.  Due to the design of
this mode, pitchbend is the most suitable
controller.  As you increase the values above
64, you will hear the sample looping in a
forward direction, increasing in pitch as the
control value goes up.  As you go below 64,
the same thing will happen, except the sample
will go backwards.  At a value of 72 (forwards)

In Pattern Select and
Envelope Select, sending

control values which do not
have a pattern or envelope

connected to them will
automatically select the

highest-numbered pattern or
envelope.  Thus if you have

less than 128 patterns or
envelopes, a CTab is more or

less required to map your
various patterns across your

control range.
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or 56 (backwards) the sample plays at its
original pitch.

Record Parameters

The next five MIDI inputs control record Parameters, and
function exactly as they do in the Zone Editor for Record
Zones.  For details see Recording a Sample, on p. 69.

Input Level.  Controls the input level of sounds as they
are recorded.  Identical to the Inp  numerical in
the Record Treatment pane.

Feedback.  Controls the amount of old sound that is
retained when loop recording.  Identical to the
Fdb  numerical in the Record Treatment pane
of the Zone Editor.

Overdrive .  Overdrive is an extension of the feedback
control -- rather than attenuating the previous
signal, it amplifies it.  You can think of it as
Feedback values of more than 100%.  In order
for Ovd  to take effect, set Fdb  to 100.
Identical to the Ovd  numerical in the Record
Treatment pane of the Zone Editor.

Erase.  This Parameter is most useful when using LiSa
as a delay system.  Increasing this value when
loop-recording sound will decrease the
amplitude of whatever you record into the
Sample Buffer at that time, and a value of 127
will erase it entirely.  This can be very useful
for ‘punching holes’ in repeatedly delayed
material.  The Erase function cannot be
connected to a CTab.

Threshold.  Identical to the TOn numerical in the
Region pane of the Zone Editor.  Sets volume
threshold for recording.

Filter Parameters

Center Frequency.  This controls the center of the
bandwidth of the filters used in Playback
Zones.  0 is lowest, 127 highest.

Bandwidth.  Sets the width of the bandpass.  0 is
widest, 127 narrowest.
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Table Editing Parameters

For changing table values in real time.  See Real-time
Control of Tables on p. 98 for details.  Note that it is not
possible to connect a CTab to any of these Parameters.

Edit Table Select.  This is an indexing Parameter, like
Envelope select.  The Controller value will
select the number of the table edited by the
other two MIDI controls.  Since CTabs cannot
be used, you can only access the first 128
tables for real-time editing

Selected Table Index.  Midi values sent here will set the
index number (X value) of the table to be
altered by Selected Table Value.

Selected Table Value.  Sets the Y value of the index
selected above.

Wave Table Parameter

Used in Wavetable Playback Zones.

Wave Table Mix.  Controls the relative volume of  the
Source and Destination waveshapes.  0 is
100% Source, 127 is 100% destination.

Mapping MIDI
Controllers – CTabs

Tables (CTabs) can be used to map linear
Controller signals to other sets of values.  For
a general description of creating and editing
tables, see Tables and Envelopes, p. 43.

Controllers

Although MIDI input effects all enabled Zones
assigned to that Control Layer, the response
of each Zone to that MIDI input does not have
to be identical.  You can map the input to any
output you desire with CTabs.  To the right of
all the MIDI-controllable Parameters in the
Zone Editor is a numerical labeled CTab.
Clicking on this will reveal a popup menu with
all available CTabs.  From here you can
choose the Control Table to which incoming
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MIDI is mapped.

MIDI input is mapped to the X value, and MIDI output to the Y
value of the CTab.  Tables of any size can be used – LiSa will
interpolate the values to the 0-128 of MIDI controllers.

Indexes

Some Zone Editor Parameters (notably envelope select and
the pattern modes) use MIDI controllers to select between
options rather than control variables.  CTabs also come in
handy for this – you can map out the full range of a Controller
to select all or a selection of items out of the Envelope or
Pattern Libraries.

Real-time Control of Tables

You can use MIDI to change table values in real time.  Tables
being used for any purpose can be changed, although it is
most powerful when used to change tables being read as
waveforms.  To do this requires at least two control sources.
Settings for real-time control of tables are made in the Control
pane of the Assignment window.

To edit a table via MIDI:

Edit Table Select.  If the Parameter is connected
to a Controller, that Controller’s value +1 will
select the table number to be edited.  (It works
like Program Change messages – an index
value of 0 will edit table 1, etc.)  If no Controller
or modulator is connected to this Parameter,
all MIDI sent to the other Table Edit
Parameters will automatically be applied to
table number 1.  Note that there is no way to
control this Parameter with a CTab, so you
may have to think carefully about what order
and where those tables are in your Table
Library.  In addition, this means that only the
first 127 tables in your Table Library can be
edited in this manner.

Selected Table Index.  The value this Parameter
receives will set the index number (X value) of
the table to be edited.  If it receives a value of
16, whatever value comes into the Selected
Table Value Parameter will change index
number 16.  This Parameter by itself changes
nothing in the table.  It is often useful to
connect a modulator attached to a sawtooth
wave the same size as the table to be edited to

If you want a Zone to
respond to some MIDI inputs

but not to others, linking a
parameter to a CTab that

contains one fixed value (for
example, 64 for the tuning
parameter) will effectively

disable it.

Real-time editing of tables
will only work when a voice
is active.    The table you

are editing may or may not
be in the active Zone, but at

least one voice must be
playing for this to work.
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this Parameter, to be able to change values
sequentially.

Selected Table Value.  Sending a value to this
Parameter will immediately change the value
(Y value) of the table at the index specified in
Selected Table Index.

Miscellaneous MIDI
Controls

Sustain and Sostenuto

LiSa also supports MIDI Sustain and Sostenuto commands,
both directly from the Status window and via MIDI.  Enabling
Sustain on a MIDI channel will keep all record or playback
Zones in the effected Voice Layers active until Sustain is
turned off for that channel, at which point all sustained notes
receive note off messages.  Enabling Sostenuto acts like
sustain as long as it is on.  When Sostenuto is turned off, all
held notes will continue to hold until the key that activated
them is pressed again.

Each of the 16 buttons next to the words Sustain  and
Sostenuto  will enable sustain or sostenuto on Voice Layers
1-16.  Clicking with the cursor in these buttons will toggle
them on and off.  If more than one Voice Layer is assigned to
a particular MIDI Channel, enabling Sustain for that Layer will
enable it for all other Layers sharing that MIDI Channel as
well.

You can also activate Sustain and Sostenuto from MIDI
messages:

•  A value of 127 from Controller No. 64 will turn on sustain for
all Voice Layers connected to that MIDI Channel, and a
value of 0 will turn it off.

•  A value of 127 from Controller No. 66 will turn on sostenuto
for all Voice Layers connected to that MIDI Channel, and
a value of 0 will turn it off.
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Sustain and sostenuto can be enabled from the keyboard for
the active Voice Layer.  ‘+’ will toggle sustain on and off, and
‘-’ will do likewise for sostenuto.

Velocity Mapping

It is important to note that velocity is always connected to the
amplitude of a Zone in the traditional MIDI manner – the
harder you hit, the louder the sound is, reaching the volume
set in the Lev  numerical when a key is struck with a velocity
of 127.  It is possible to change the relationship between
velocity and volume response by using a CTab, however.  If
you look at the Play Treatment pane in the Zone Editor,
pressing Shift will turn the value of the Lev  numerical into the
word Vel.  The CTab to the right of the numerical is
connected to velocity.  By adding a new table here, you can
change the relationship between velocity and volume.  In the
example, a table titled Inverse, which goes from 127 to 0 has
been inserted, so a soft touch will be loud, and a loud one
soft.

Amplify Current Zone

It is possible that you will record a sound at a
volume that is unsuitably low in volume when
played back.  It is possible to amplify the
sample region of your current Zone (that is,
the last Zone played, or the one visible when
you have Show Current Zone selected) by
sending it a MIDI control value.  This is set
from the System Settings... menu item in the
Global menu.  (See p. 16)

In Amplify Current Zone , there are two variables.  The
first is the controller number.  Sending any value on this
Controller on any channel will cause the sample region of the
selected Zone to be amplified by the percentage specified in
the numerical labeled %Gain .  (This works best with a
controller you can send from a button rather than a slider --
every time you change the slider value, you will ‘bump up’ the
amplitude of the signal.)  This numerical has a range of 0 -
200% amplitude of the original signal.

Using this will permanently change the sound in the Sample
Buffer, although not in your original soundfile, if the sample
comes from one.  Repeated amplifying will cause distortion
akin to analog distortion, not digital clipping.  It also is slightly
slower than real-time.  If your region is fairly short, it is fast
enough to use in performance, but not instantaneous.  The
speed of your computer will also effect this -- it’s best to
experiment a bit before trying it out on stage.
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Envelope Followers

The audio input into LiSa can be
converted to MIDI.  Audio can generate
note on and off messages, and be
attached to MIDI controllers.  LiSa uses
the amplitude of the incoming signal to
generate these MIDI values.  Settings for
the Envelope Followers are made in the
System Settings item in the Global menu.
This MIDI is treated exactly as MIDI
coming from an external device.  Settings
can be different for Left and Right inputs.

EF Channel.   All MIDI from the Envelope Followers is
sent on the channel set here.

EF Note Nr .  When the Envelope Follower detects
input above the threshold level, it will send a
note on message for this note on the MIDI
channel specified above.  When the signal
goes below the threshold, LiSa will send a note
off.

EF Threshold .  Here you can set the threshold level
for note on and off messages.  Amplitude
above the threshold will generate a note on,
and when it falls below the threshold, a note
off.  Setting this numerical to zero will cause a
note on when any audio is received, and at
127 the envelopes will never be triggered.

EF contr. Nr.   Here you set the Controller number
for the Envelope Follower.  To disable EF
control, set these numericals to 0, which does
not send MIDI to controller 0, but turns off the
envelope generators.  (Controller 0 is thus
unavailable for use with the Envelope
Followers.)

To use MIDI from the envelope followers, treat it like any
other MIDI input:

For Note on messages, just drag a Zone to the key
specified, and it will be activated once the EF
passes the threshold.

For Controllers, create a new Controller in the
Controller Library with the number of the MIDI
controller you have assigned in the dialog box,
and treat it as any other external Controller.

Note that these settings
have nothing to do with

recording audio as it
comes in.  These settings

are only for MIDI.
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Controlling LiSa from the
Computer
When editing a Setup, it is sometimes convenient to be able
to test it without having to use an external MIDI device.  This
can be done in two ways: Notes can be activated directly
from the computer keyboard, or you can use the Mouse
Control window.

Playing Notes from the

keyboard

Setup

In the Global menu is the item Keyboard MIDI Map…  Selecting
this will present a window with a set of numericals, three for

each of the alphabetical keys of the keyboard.
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Using these numericals, you can set a channel value, note
number, and velocity for the alphabetical keys.  The note
assignments are saved with your Setup.

Behavior

To activate computer keyboard MIDI, press the forward slash
(/) key.  This will toggle keyboard MIDI on.  Pressing slash
again will deactivate it.  While keyboard MIDI is active, none
of the alphabetical Cmd-key menu shortcuts will work,
although the items will still work from the menu bar.
Numerical Cmd-key shortcuts, and the arrow keys, will
continue to function normally.

The number of notes you can play from the keyboard at a
time varies from computer to computer.  You can, of course,
enable Sustain for the MIDI Channel you are using.  Both
Sustain and Sostenuto work normally.

The Mouse Control Window

The Mouse Control Window is available from the Windows
menu, and allows you to both activate notes and use up to 2
Controllers simultaneously.

Playing Notes

The main pane of the Mouse Control Window is an elongated
representation of the current Voice Layer keyboard.  Clicking
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in this area of the window will activate the note.  The higher
up in the window you click, the greater the velocity.  The note
will remain on as long as the mouse button is held down.
Click-dragging will play notes as you move the mouse
around.  The most recent note played is displayed at the
bottom of the window.  Sustain and Sostnuto for the current
Voice Layer can be activated using the buttons at the top of
the window.

Using Controllers

You can imitate the behavior of 2 simultaneous Controllers
using the mouse and the modifier keys.  In the numericals on
the left, you can assign 2 Controllers to the X and Y axes of
the cursor’s movements.  By pressing the Shift, Option, or
Command keys, click-dragging the mouse will stop playing
notes and send Controller information instead.  (You can use
the sustain or Sostenuto buttons to keep a note playing while
you use the Controllers.)  Only one modifier key may be used
at a time.  Current Controllers and their values are displayed
in the bottom of the window when a modifier key is down.
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AAAAppppppppeeeennnnddddiiiixxxx    1111::::    BBBBaaaassssiiiicccc
OOOOrrrrddddeeeerrrr    ooooffff    OOOOppppeeeerrrraaaattttiiiioooonnnnssss
This section is intended to give you a quick idea of the basic
procedure involved in creating a LiSa Setup – with so many
details it is sometimes hard to figure out where to start.  We
assume that you are familiar with all of LiSa’s windows and
functions, but whether you are just trying to get started and
make some music, or if you have read the manual, this
should clarify the order of events involved in getting
something happening.

•  Open LiSa.  A new Setup, called Untitled Setup, will
appear.  (The window arrangement will depend on what
was open the last time you started the program, and we
will assume that you will be able to locate or open
whatever windows may be called for.)  You are now in an
open Preset entitled ‘Init Preset’, and one Zone, called
‘Play 5 sec.’ has been created and is visible in the Zone
Editor.  Check your incoming MIDI – if it is working, you
will see the input displayed in the Status Window.

•  Get a list of available samples from your hard disk, so you
can decide which ones to load into the Sample Buffer.
Bring the Sample Library to the front.  If you already know
what samples you want to load, you can select them
individually by using the Add  button, or to see all
available soundfiles on your disk, use the Scan  function.

•  Put a sample into the Sample Buffer.  Click-drag the
selected sample to the Sample Buffer pane of the Status
window or to the Sample Editor window.  The sample will
appear in the window.

•  Create a new Zone (You could use the pre-made Zone if
you felt like it, we’re just running through the procedure)
by clicking on New in the Zone Library.  You will see the
new Zone listed in the Library, and appear in the Zone
Editor.  Rename it by typing in the Name box in the Zone
Editor.

•  Adjust the size of your Zone to the current sample in the
buffer.  This can be done using the numericals in the Zone
Editor window, or if you have the Sample Editor open, you
can highlight the area of the sample and select Enter
Section in Zone from the Edit menu.

•  Assign a keyrange to the Zone.  Click-drag the Zone from
the Zone Library to the virtual keyboard in the Status
window, and assign it to a key or range of keys.
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•  Select a MIDI Parameter to control.  Drag Tuning  from the
Parameter Library to one of the small rectangles in the
Parameter Control pane of the Assignment window.  You
could also do this by clicking on the rectangle, which will
present a pop-up menu with the same options).  To
control it with the modulation wheel, select Modwheel from
the pop-up menu directly to the right of the rectangle with
the Tuning icon in it.

•  Play one of the notes on your keyboard within the Zone’s
keyrange, and move the modwheel up and down.  You
should hear the pitch bending both above and below the
original pitch of the sample.

•  To have the modwheel only transpose the sample up, click
on the CTab box next to the Tun  numerical in the Zone
Editor.  Select New Table… from the pop-up menu.  The
Table editor will open with a new table full of random
values.

•  Rename the table something useful like ‘trans up,’ and
adjust the size to 128 by typing in the Size numerical in
the top right-hand corner.

•  Change the table view to Numerical by clicking on the
Numerical View icon.  Shift-click on the first numerical,
and change its value to 64.  Do the same with the last
numerical, and change it’s value to 127.  Click on the Line
Segment button, and the table will now have linear values
from 64 to 127.

•  Close the Table editor, and you will see the name of your
new table in the CTab box next to the Tun  numerical.

•  Play the note again, play with the modwheel, and you will
hear the pitch only transpose up.

•  If you want the sample to be automatically be loaded with
this Preset, drag the sample name to the Sample Column
in the Preset window.

The above steps represent the basic order of operations
while designing a Setup in LiSa.  You create a new Zone and
assign it a region and keyrange, and change its function and
modes in the Zone editor if you wish.  You can then set its
Parameter control behavior in the Assignment window, and
tweak it using CTabs and envelopes.
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Polyphony and Voice
Allocation
Number of Voices

LiSa is designed to be able to play a maximum of 128 voices
(sounded notes) simultaneously.  The actual number of
voices you will be able to get depends on several factors:

•   The speed of your machine.
•  The kinds of Zones you are using, as some are more

computationally expensive than others.

•  Number of Filters you are using.  Filters slow LiSa down
considerably.

•  Playback Quality of your samples.  If you are using Good
playback quality, you will get more voices than if you use
Best.

Sounding voices is naturally the most time-consuming task on
the part of your computer’s processor, so the faster the
computer is, the more voices it can sound.  LiSa can make
very big demands on your computer’s CPU, and will even
‘steal’ processor time from other programs in order to
produces all the voices that are being demanded of it.  In a
case when you are using LiSa on a computer simultaneously
running other programs (for MIDI control, for example)
problems could obviously develop.

It is possible to limit the amount of processor load that LiSa
will occupy (see System Settings, p. 17).  You may need to
experiment with your particular set of applications to
determine how many voices you can assign without slowing
down your other programs.

Voice Priority

It is not unusual (particularly when generating MIDI from a
computer) to wind up in a situation where more voices are
being called for (in the form of active record or playback
Zones) than LiSa has available.  In that case, LiSa follows a
strict order in deciding which voices will be sacrificed first to
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perform other tasks.  They are given priority in the order
below, with the ones sacrificed first at the bottom of the list.
The number of voices being played does not effect loading
and saving soundfiles.

•  Playback Zones (High Priority).  Playback Zones can have
their voice allocation prioritized into high or low priority.  A
high priority Zone will always take precedence over any
other Zone, and if any record tasks are called for, a low
priority Zone will be dropped first.  Note that this means
that if all voices that are playing are set to high priority,
you will not be able to record.

•  Record Zones.  If you are using all available voices for
playing and try to record a new sample, low-priority
playback voices will always be sacrificed to perform the
record.  Also, to record a sample requires two voices, so if
your maximum number of voices is 12 and you’re using
them all, when you activate a Record Zone, you will have
10 still playing.

•  Playback Zones (other than High Priority) All other playback
zones will always be dropped first, starting from the one
that has been playing the longest.
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RRRReeeeccccoooorrrrddddiiiinnnngggg
To record a stereo sample in LiSa, it is necessary to use two
Record Zones of identical length with different sample
regions.  Each of the Zones must be in a different Voice
Layer, and assigned to the same MIDI note to guarantee
simultaneous activation.  They can then be played back in
stereo using two similarly arranged Playback Zones.

•  Create a record Zone.  Title it ‘Rec Left’, or something
similarly handy.  Holding down the Shift key, set Pan to
-100 and Inp  to Left.

•  Duplicate the Zone in the Zone Library, using the Duplicate
command in the Edit menu (Make sure the Zone Library is
on top!).  In the Zone Editor, rename the new Zone ‘Rec
Right’.  Change the Stt  numerical to a point beyond the
end of ‘Rec Left’, and once again holding down Shift, set
Pan to –100, and Inp  to Right.  You now have 2
identically sized zones recording in different parts of the
Sample Buffer.

•  Assign the Left Zone to a virtual key.  Check the
Assignment Window, and make sure you are on Voice
Channel 1.  Drag ‘Rec Left’ from the Zone Library to a
key, say number 60.  MIDI note C3 on channel 1 will now
activate this Zone.

•  Assign the right Zone to the same key in another Voice
Layer.  Bring up Voice Layer 2 by clicking on its button in
the Assignment Window.  Drag ‘Rec Right’ to virtual key
60.

•  Change the MIDI Channel of Voice Layer 2.  Click and hold
on the selection button for Voice Layer 2, and a popup
menu will appear allowing you to set the MIDI channel on
which this Layer will respond.  Select Channel 1.  Both
Zones will now be activated when LiSa receives a MIDI
note on for C3 on MIDI Channel 1.

To play back a sample recorded in this manner, duplicate
both Record Zones, and in the Zone Editor change their
function to Playback.  This guarantees identical Sample
Regions.  Set the Pan Parameter of the ‘Rec Left’ copy to
-100, and of the copy of ‘Rec Right’ to 100.  Assign these to
identical keys or keyranges on Voice Channels 1 and 2
respectively, and you will be able to play back your recorded
stereo samples.
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File Menu

•  New Setup…  Creates new Setup, closes currently open
Setup, including Libraries.

•  Open Setup…  Opens Setup, loads it’s Libraries.
•  Load Sample…  Loads a sample into the Sample Buffer

starting from the beginning of the buffer.  Overwrites old
material.  Only way to access samples not in the Sample
Library.

•  Load Library…  Opens a dialog allowing you to load a Library
from another Setup into your open Setup, with the option
to replace or append the current Library.

•  Close Window.  Closes topmost window

•  Save Setup…  Saves current Setup, including preferences
and Libraries.

•  Save Setup as…  Save current Setup under a new name,
which will resave Libraries under the new name as well.

•  Save Sample Buffer…  Saves Sample Buffer contents as new
soundfile, either the entire buffer or the current view
available in the Sample Editor.

•  Save Library As…  Saves a Library under a new name.
•  Quit.  Quits LiSa.
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Edit Menu

•  Undo

•  Cut

•  Copy

•  Paste

•  Clear

•  Duplicate.  Standard Mac edit
commands.  Note that not all edits
are available in all windows, and
that edits only apply to the topmost
window, identifiable by the green
diamond in the upper-left corner.

•  Clear Sample Buffer.  Completely clears all samples in the
Sample Buffer.  Output and Process buffers remain
untouched.

•  Enter Selection in Zone.  When the Zone Editor is topmost,
the start points and length of the highlighted area will be
applied to the current Zone (the one visible in the Zone
Editor).

•  Enter Current Region in Zone.  Enters the current sample
region in the current Zone.  Useful if changing a Zone’s
region via MIDI, and wanting to make it the Zone’s initial
state.

•  Normalize Current Sample Region.  Normalizes the Sample
region of the current Zone.  Cannot be undone.

•  Find Selected Zone
•  Find Zone Again.  Will flash the Zone selected in the Zone

Library in the virtual keyboard.  Will look through all
Presets in a Setup, so store your Preset before using.



112

Global Menu
The preferences stored in the dialogs available from this
menu are saved with the Setup, so each setup may have
different values for all of these options.

•  System Settings…  Opens System Settings dialog, where you
can set basic preferences for LiSa’s system.

•  Size of Buffers…  Opens a dialog in which you can resize all
three of LiSa’s audio buffers.

•  MIDI Setup…  Set OMS MIDI input and Thru.

•  Pitch Bend Range…  Sets Pitch bend range.  Min=1 semitone,
max=60 semitones.

•  Keyboard Map…  Opens a dialog in which you can make
MIDI channel, note number, and velocity for the
alphabetical keys on your computer keyboard.

Presets Menu

•  Load Selected Preset.  Loads Preset selected in the
Preset window into LiSa.

•  Store Current Preset.  Stores current Preset in it’s
current location

•  Store Current Preset As…  Stores current Preset in
any location in Preset window, with a new name.

•  Clear Current Preset.  Removes all Zones,
Controller assignments and samples from current
Preset.  Keeps memory reserved.

•  Delete Selected Preset.  As above, but also releases
memory assigned to the Preset.  Cannot be done on
currently loaded Preset.
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Windows Menu
Opens the various windows available in LiSa.  Self-
explanatory.

Options Menu

•  Show Current Zone.  When checked, the Zone
Editor will display the Zone last played, either via
MIDI or from the Mouse Control Window.

•  Stop Notes on Preset Change  When checked,
all notes will be silenced and Zones reset to their
original Sample Regions when changing
Presets.

•  Auto Save Recording Sessions.  When enabled, all record
Zones with Auto Save Session enabled will save their
recordings to disk.

•  Show Current Sample Pointer.  Displays numerical location of
the sample pointer of the last Zone activated in the
System Messages pane of the Status Window.

•  Show Length in kSamples/Show Length in Seconds.  Toggles
between these two modes of time display.



114

Help Menu
•  Show Balloons/Hide Balloons.  Toggles Balloon Help.
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Keyboard Shortcuts
General

•  Shift:  reveals second aspect of dual numericals or shows
second special parameter.

•  Up Arrow: jump to next available Preset
•  Down Arrow: jump to previous available Preset.
•  Left Arrow: show previous available structure in the topmost

Editor Window.

•  Right Arrow: show previous available structure in the
topmost Editor Window.

•  +: Toggles Sustain for the MIDI channel used by the current
Voice Layer.

•  -: Toggles Sostenuto for the MIDI channel used by the
current Voice Layer.

•  /: Toggles Computer Keyboard MIDI for alphabetical keys.
•  A-Z keys.  When Computer Keyboard MIDI is enabled,

plays notes as chosen in the Keyboard Map… dialog.

Sample Editor

•  Option-Left Arrow and Option-Right Arrow will nudge the
left-hand edge 1 kB of samples of the selected area.

•   Option-Up Arrow and Option-Down Arrow will nudge the
right-hand edge to the right and left, respectively.

Tunings

•  Caps lock:  reveals custom scaling keyboard.
•  K: quarter-tone tuning.
•  N: 12-tone equal tempered tuning.
•  U: unison, all notes to play at MIDI note 60.
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absolute region start, 51, 92
Activate Mode, 60
Advance Mode, 59, 72

in patterns, 64
Amplify Current Zone, 99
Amplitude, pattern parameter, 65
Assignment Window

and control parameters, 85
and loading Presets, 29
and retuning the keyboard, 53
and Voice Layers, 87
assigning keyranges, 51
creating keyranges, 23
overview, 7

Auto Save Recording, 73, 81, 112
Autopan, 57
back and forth parameter, 56
Back and Forth playback mode, 94
Buffers

resizing, 15
controller editor, 85, 89
Controllers. see MIDI
Copy Buffer Zone, 26
Copy Buffer Zones, 83
CPU Load, 17
CTab. See Tables
Dpt Parameter, 57
Editing Functions, 4
elements, pattern, 63
Env Parameter, 55
Envelope Followers, 100
Envelopes, 47

amplitude, 61
editor, 48
filter, 62
in Wavetable Zones, 58

Fdb parameter, 74
Filters, 62
function

definition, 6
Fuz Parameter, 56
Global Settings, 16
Inp Parameter, 74
Input Gain, setting, 17
Jump To, pattern parameter, 66
Keyboard transposing, 53
Keyranges, 22

creating, 23
deleting, 23

Len parameter, 51
Length, parameter, 24
Length, pattern parameter, 4, 42, 65, 84, 92, 112
Lev parameter, 55
Libraries

Zone, 19
Libraries, 31

Controller, 88
Envelope, 48
Parameter, 88
Pattern, 64
Sample, 34
Table, 43, 97

Load Sample Zones, 25, 77
Load Session Zone, 26
Load Session Zones, 81
Looping mode, 60
Memory, 11
MIDI

changing presets, 31
channel and voice control, 90
channels, 87
configuring, 15
connecting, 13
controller behaviors, 91
controlling patterns with, 66
creating controllers, 89
enable/disable, 60
envelope followers, 100
from the mouse and keyboard, 101
global settings, 16, 84
keyboard MIDI map, 101
main functions, 85
mapping with CTabs, 24, 43, 52, 96
MIDI monitor pane, 86
parameter control

overview, 85
parameter control pane, 86
sustain and sostenuto, 98
velocity mapping, 99
virtual keyboard, 23
voice layers, 23, 87

Modulator Running Mode, 61
Modulators, 90
Moving Soundfiles, 36
Mvr parameter, 51, 79
Normalize, 42, 110
Numericals

and time descriptions, 4
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dual, 4
using, 3

Offset, pattern parameter, 64
Once mode, 60
Output buffer, 83

resizing. See Buffers, resizing
Output Buffer Rec Start, 84
Ovd Parameter, 74
Overdub mode, 72
Pan

pattern parameter, 66
playback parameter, 55

Parm, pattern parameter, 67
Pattern modes, 56
Pattern Select., 94
Patterns

Modes, 63
Pattern Editor, 64

Pitch, 53
Pitch Shift, pattern parameter, 65
Play Direction, pattern parameter, 66
Play Treatment Pane, 22
Playback Mode, 56
Playback Quality, 30
Presets, 27
Process Buffer, 84

resizing. See Buffers, resizing
Program Change message, 31
range, 5
Record Modes, 71
recording, 75

auto save sessions, 73
from CD, 69
input level, 75
record monitor, 75
stereo, 69, 108
threshold, 71

Rename Samples, 36
Repeats, pattern parameter, 65
Replace mode, 72
Res parameter, 57
Resonator, 57, 94
Restart Mode, 59
Sample buffer

loading samples into LiSa, 37
overview, 36
resizing. See Buffers, resizing
saving samples from, 38

Sample Editor, 39
copying tables from, 47
dragging samples to, 37
editing, 41
navigating in, 39
overview, 9
sizing regions from, 24

sample region, 5
Samples. See also Sample Buffer, soundfile

loading into LiSa, 37, 42, 77

Scale Retuning, 53
Scrub, 57
Sessions, 82
Sessions, 81
Setups, 31
Snapshots, 40
Sound control Panel, 12
Sound Thru, setting, 17
Spiral Algorithm, 56
Spl Parameter, 56
Status Window

CPU use, 17
dragging samples to, 37
input level monitor, 75
MIDI monitor pane, 86
overview, 9
record monitor, 75
Sustain and sostenuto, 98
voices monitor, 76, 84

Step Mode, 59
in patterns, 64

Stop Notes on Preset Change, 31
Stt parameter, 51
System Channel, 16
System settings

computer, 12
LiSa, 17

Tables, 43
as modulators, 90
as wavetables, 59
copying from Sample Editor, 47
function buttons, 45
Mapping MIDI with, 96
real-time control of,, 97
Wavetable Zones, 58

TOn parameter, 71, 75
TOn/TOf parameter, 71
Trigger mode, 60
Velocity, 55, 99
Virtual Keyboard, 23

dragging samples to, 37
quick Zone creation from, 52
scale retuning, 53

Voice Allocation, 60, 68, 106
Voices monitor, 76
Wavetable Synthesis, 58
Windows, how to use, 2
Zone Editor, 20

Copy buffer pane, 83
filters, 62
load sample file pane

static, 77
load session file pane, 81
overview, 8
play treatment pane, 55
Region pane, 21
sample region parameters, 51
sizing regions from, 24
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Zone information pane, 20
Zone Parameter Control menu option, 60
Zone Reset, 93
Zones

finding, 23
Functions, 25

Load
Dynamic, 79
Static, 77

playback, 50
quick creation, 52
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